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前言 

Altium Designer 文档： 

英文官方： 

http://www.altium.com/documentation/18.0/display/ADES/From+Idea+to+Manufacture+-+Driv

ing+a+PCB+Design+through+Altium+Designer#!FromIdeatoManufacture-DrivingaPCBDesignthro

ughAltiumDesigner-CreatingaNewPCBProject 



您将要创建原理图并设计印刷电路板（PCB）的设计是一种简单的非稳态多谐振荡器。 该电路如下

所示，它使用两个通用 NPN 晶体管，配置为自运行稳定多谐振荡器

 

您已准备好开始捕捉（绘制）原理图。  

一、绘制原理图 

1.创建一个 PCB 项目。 

File » New Project » PCB Project

 



2.向项目添加原理图 

 

3.设置文档选项 

 Tools » Preferences 

在开始绘制电路之前，需要设置适当的文档选项，包括“纸张大小”，“捕捉”和“可见”网格。 



 

4.Altium Designer 中的组件和库 

注：本教程的这一部分将介绍使用组件（来自库或 Altium 内容库）的两种不同方法。 在下一节中，

您将从 Altium Content Vault 中找到并放置您需要的组件。 

 

安装在电路板上的实际组件在设计捕获过程中被表示为一个原理图符号，并作为电路板设计的 PCB

丝印。 Altium Designer 组件可以是： 



•由本地库创建或放置的； 

•直接从 Altium Content Vault 放置，这是一个全局可访问的组件存储系统，包含数千个组件，每

个组件都有一个符号，封装，组件参数和供应商链接。 

 

Altium Designer 中可以使用以下组件存储选项： 

 
Schematic Library： 

原理图元件符号在原理图库（* .SchLib）中创建，并存储在本地。 每个符号都可以通过添加到

PCB 印迹的链接成为一个组件，然后添加组件参数来详细说明组件的规格。 

 

PCB Library： 

PCB 封装（模型）存储在本地存储的 PCB 库（* .PcbLib）中。 占地面积包括电气元件（例如焊盘）

以及机械元件（例如组件覆盖层，尺寸，胶点等）。 它还可以包含 3D 定义，通过放置 3D Body

对象或导入 STEP 模型创建。 

 

Library Package / Integrated Library： 

除了直接从原理图库和 PCB 库中工作，您还可以将组件元素编译为集成库（* .IntLib，本地存储）。 

这样做会产生一个包含所有模型和符号的便携式的库。 一个集成库从一个库包（* .LibPkg）编译

而来，它基本上是一个特殊用途的项目文件，其源图形（* .SchLib）和 PCB 库（* .PcbLib）作为

源文件添加到它。 作为编译过程的一部分，您还可以检查潜在问题，例如缺少模型以及原理图引

脚和 PCB 焊盘之间的不匹配。 

 

Altium Content Vault： 

Altium Content Vault 不仅仅是一个库。 组件存储在云中，可以从任何可以访问互联网的地方访

问。 Altium Content Vault 组件包括：符号，封装，组件参数和供应商链接。 它们按制造商或

按照泛型的包装类型分为文件夹。 

 

5.访问组件 

通过以下方式访问组件： 

•本地库组件的库面板; 或通过 

•Altium Content Vault 组件的资源管理器面板。 

点击应用程序右下角的 Panels 按钮即可访问这两个面板。 



 

 

下面显示了用于访问组件的两个面板。 

 



 

 

6. 使库可用于访问组件 

在 Altium Designer 中，可以从可用库中放置基于库的组件。 可用的库包括： 

•当前项目中的库 - 如果库是项目的一部分，则其中的组件可自动在该项目中进行放置。 

•已安装的库 - 这些库已安装在 Altium Designer 中，它们的组件可用于任何打开的项目。 

 

库被安装在 Available Libraries 对话框的 Installed 选项卡中。 要打开对话框，请单击“库”

面板顶部的“库”按钮。 如果面板当前不可见，请单击»库以显示它。

 

 

7. 在库中查找组件 

为了帮助您找到所需的组件，Altium Designer 提供了强大的库搜索功能。 尽管在预安装的库中

有适合于多谐振荡器设计的组件，但了解如何使用搜索功能来查找组件非常有用。 



 

单击“库”面板上的“搜索”按钮即可访问“库搜索”对话框。 对话框的上半部分用于定义要搜

索的内容，下半部分用于定义搜索的位置。 

 

搜索的范围可以在以下库中： 

•已安装（可用库）或 

•位于硬盘上的库（路径上的库）。 

 

 

如果您用这个库，第一步是寻找合适的通用 NPN 晶体管，例如 2N3904。 教程组件将从 Vault 中放

置，稍后将讨论它。 

 

8.在可用库中查找组件 

已安装的库列在面板顶部的下拉列表中，单击以选择库并显示存储在其中的组件。 从列表中选择

其他设备库，然后使用面板中的组件 Filter 在库中找到所需的 2N3904 组件（如下图所示）。 由

于已经安装了 Miscellaneous Devices 库，因此该组件已准备好放置。 不要放置它，而是使用

Altium Content Vault 中的晶体管。 

 



 

9. 让 Altium Content Vault 可用于访问组件 

Altium Content Vault 是一款使用 Altium 设计软件的设计人员的在线资源，该软件可存储数十万

种通用和制造商特定的组件。 在线存储组件意味着 Altium 可以继续创建和发布最新组件，而不会

影响每个设计人员安装 Altium 软件。 

 

要访问 Altium Content Vault 中的组件，您必须首先连接到它。 这是通过启用 Preferences（选

项）对话框的数据管理 - 服务器页面中的自动连接到 Altium Content Vault 选项来完成的（点击

应用程序左上角的按钮以访问该对话框）。 

 

 



 

一旦连接到 Altium Content Vault，您就可以将 Vault 中的组件放入您的设计中。 

请注意， Preferences（选项)对话框中提到的登录不需要访问 Altium Content Vault 中的组件。 

 

10.在 Altium Content Vault 中查找组件 

一旦连接到 Altium Content Vault，您可以浏览或搜索组件。 这在 Explorer 面板中完成，选择

Panels»Explorer 来显示面板。 该面板包含强大的搜索功能，将搜索字符串输入面板顶部的搜索

栏并按 Enter 键，如下图所示。 使用面板左下方的选项卡在搜索结果和文件夹浏览之间切换。 

 



在 Altium Content Vault 中搜索通用晶体管 BC547。 点击查看感兴趣的组件。 

11. 在浏览器面板中工作 

资源管理器面板包含多个部分，可根据需要调整其大小。 花一些时间来查看面板的功能和行为，

右键单击不同区域中的特定于上下文的命令。 

 

使用供应链模式检查所选组件的价格和可用性。 

•将组件组织在文件夹中，使用面板左侧的服务器文件夹部分浏览文件夹 - 单击底部的文件夹选

项卡以显示它们。 

•Altium Content Vault 中存储了大量组件，如上所述，搜索效率更高。 

•面板的较低区域有多种显示模式，包括： 

预览，生命周期，供应链，使用地点和原点 

(Preview, Lifecycle, Supply Chain, Where-used, and Origin)。 单击选项卡以选择所需的模

式，如上图所示。 

•要查看找到的组件存储在哪个文件夹中，请右键单击该组件并选择“Navigate To 导航至”命令。 

 

12. 在原理图上放置元件 

组件从“库”或“资源管理器”面板放置到当前原理图页面上。这个过程如下所述： 

 

a.从库面板放置 

Libraries Panel 

•点击放置按钮 - 组件出现在光标上，放置并点击放置。放置组件后，同一组件的另一个实例将出

现在光标上，右键单击以退出放置模式。 



•双击 - 双击面板中组件列表中的组件，该组件显示为浮动在光标上，放置它并单击放置。放置组

件后，同一组件的另一个实例将出现在光标上，右键单击以退出放置模式。 

•单击并拖动 - 单击该组件并将其拖动到此工作表上，该模式要求按住光标，释放光标时放置该组

件。 

 

b.从资源管理器面板放置 

Explorer Panel 

•右键单击组件并选择放置，该组件显示为浮动在光标上，放置它并单击放置。请注意，如果资源

管理器面板悬浮在工作区上，它将会淡入以允许您查看原理图并放置组件。放置组件后，同一组件

的另一个实例将出现在光标上，右键单击以退出放置模式。 

•单击并拖动 - 单击并从“资源管理器”面板中拖放组件，然后将其放到原理图上。该模式要求按

住光标，释放光标时放置组件。根据互联网连接的速度，组件放置之前可能会有短暂的延迟。 

 

放置提示 

当组件浮动在光标上时，您可以： 

•按空格键以 90 度为增量逆时针旋转。 

•按 X 键使其沿 X轴翻转，按 Y使其沿 Y轴翻转。 

•按 Tab 键显示“属性”面板并在放置之前编辑对象的属性。 输入的值将成为默认值，如果指示符

具有相同的前缀，它将自动递增。 

•在组件放置期间，如果触摸窗口边缘，软件将自动平移。 自动平移在“Preferences（选项）”

对话框的“原理图 - 图形编辑”页面中进行配置。 如果您不小心将光标移动到所需位置，而组件

在光标上浮动，则您可以： 

◦Ctrl +滚轮缩小并再次放大，或者 

◦右键单击并拖动以围绕或滑动原理图 

◦Ctrl+ PgDn 再次显示整个表格。 

 

在放置期间使用“属性”面板 

在对象放置期间，如果按下 Tab 键，编辑过程将暂停，交互式属性面板将出现。 默认行为是为了

最常见的编辑字段突出显示，随时可以编辑。 如果编辑过程暂停，您可以使用光标移动到面板中

的另一个字段。 

完成编辑后，单击暂停按钮（ ），如下图所示，返回到对象放置。 或者，按 Enter 完成对象

编辑并返回到对象放置。 



 
在放置过程中按 Tab 键时，编辑处于暂停状态 - 单击暂停按钮返回放置组件。 

 

多谐振荡器零件(查找和放置) 

下一步是在 Altium Content Vault 中搜索多谐振荡器电路中使用的以下组件。 

 
Designator  Description   Vault Item-Revisionor Library Component Name    Comments 

 

 

Q1, Q2  

General purpose NPN transistor, eg BC547 or 2N3904  

CMP-1048-01437-1  

searched Vault for BC547, chose BC547C  

 

R1, R2  

100K resistor, 5%, 0805  

CMP-1013-00122-1  

searched Vault for 100K 5% 0805  

 

R3, R4  

1K resistor, 5%, 0805  

CMP-1013-00074-1  

searched Vault for 1K 5% 0805, note that the search also returns 1K3, 1K8, etc 

  

C1, C2  



22nF capacitor, 10%, 16V, 0805  

CMP-1036-04042-1  

searched Vault for 22nF 16V 0805  

 

P1  

2-pin header, thruhole  

CMP-1024-00327-1  

searched Vault for header, 2-pin, vertical 

 

放置组件后，原理图应如下图所示。 

 

您可以继续查找并放置组件。 请注意，下面的可折叠部分包含放置过程中编辑的提示，这比放置

后编辑更有效。 如果您选择在放置组件之前离开编辑，请双击组件进行编辑。 

 

 

A 查找和放置晶体管 

1.选择视图»适应文档（快捷键：V，D）以确保您的原理图表占用完整的编辑窗口。 

2.使用刚描述的搜索技术，使用 Vault 面板搜索并找到晶体管 BC547。 

3.在搜索保管库时，它将首先将结果集群以显示包含可能组件的文件夹。 对于晶体管搜索，所有

结果都在同一个文件夹中，名为通用晶体管。 单击超链接打开该文件夹的搜索结果，然后单击第

一个项目，CMP-1048-01437-1。 

4.该组件将显示在资源管理器面板中，您可以在底部显示预览并检查符号，封装和组件参数（您可

能需要调整较低部分的大小以显示所有预览内容）。 



 

 

5.点击选择需要的晶体管，然后右键单击它以显示上下文菜单（如上所示），然后选择放置。 光

标会变成十字线，你将会看到晶体管的图像浮在你的光标上。 您现在处于部分放置模式。 如果将

光标移动，晶体管将随之移动。 

 

不要放置晶体管！ 

6.在将部件放置在原理图之前，您可以编辑其属性 - 可以为浮动在光标上的任何对象执行该属性。 

当晶体管仍悬浮在光标上时，按 Tab 键打开交互式“属性”面板。 默认行为是自动突出显示面板

中最常用的字段，准备编辑，在这种情况下，它将是指示符。 请注意，面板的每个部分都可以单



独展开或折叠，这意味着您的面板可能看起来不同。

 

 

7.在面板的属性部分中，键入指示符 Q1。 

8.确认 Comment 字段的 Visibility 控件设置为 visible（ ）。 

9.将所有其他字段保留其默认值，然后单击暂停按钮（ ）返回零件放置。 

10.移动光标，贴上晶体管符号，将晶体管稍微放置在薄片中间的左侧。请注意当前捕捉网格，它

显示在应用程序底部状态栏的左侧。它默认为 100mil，您可以按 G快捷键在对象放置期间循环可

用的网格设置。强烈建议将捕捉网格保持在 100mil 或 50mil，以保持电路整洁，并且可以很容易

地将电线连接到引脚。对于这样一个简单的设计，100mil 是一个不错的选择。 



11.一旦您对晶体管的位置感到满意，可以通过鼠标左键单击或按下键盘上的 Enter 键将晶体管置

于原理图上。 

12.移动光标，您会发现晶体管的副本已放置在原理图表中，并且您仍处于部分放置模式，晶体管

轮廓浮在光标上。该功能允许您放置多个相同类型的零件。 

你准备好放置第二个晶体管。这个晶体管与前一个晶体管相同，因此在放置它之前不需要编辑它的

属性。当您放置同一零件的多个实例时，软件将自动递增零件标识符。在这种情况下，下一个晶体

管将被自动指定为 Q2。 

14.如果您参考之前的示意图，您会注意到 Q2 是作为 Q1 的一面镜子绘制的。要水平翻转悬浮在光

标上的晶体管的方向，请按下键盘上的 X 键。这沿着 X轴翻转组件。 

15.移动光标将零件放在 Q1 的右侧。要更准确地定位组件，请按两次 PgUp 键以放大两个步骤。你

现在应该可以看到网格线。 

16.一旦您定位了零件，请鼠标左键单击或按 Enter 键放置 Q2。再次将你“持有”的晶体管的副本

放置在原理图上，并且下一个晶体管将浮在准备放置的光标上。 

17.由于所有晶体管已放置，请通过单击鼠标右键或按 ESC 键退出零件放置模式。光标将恢复为标

准箭头。 

 

B 查找并放置电阻 

1.使用刚刚描述的搜索技术，在 Explorer 面板中搜索合适的 100K 5％0805 电阻。搜索应返回项目

修订版 CMP-1013-00122-1。 

2.右键单击所选电阻以显示上下文菜单，然后从菜单中选择放置。 

3.当电阻悬浮在光标上时，按 Tab 键打开属性面板。 

4.在面板的属性部分，输入代号 R1。 

5.确认注释字段的可见性控件设置为可见。 

6.展开“属性”面板的“足迹”部分，并确认足迹模型设置为 RESC0805（2012）_N。您将看到该

组件附有 3个封装模型，IPC 低密度（_M），IPC 中等密度（_N）和 IPC 高密度（_L）。在设计同

步期间，此处选定的占位面积将被转移到 PCB。 

7.将所有其他字段保留为其默认值，然后单击暂停按钮（ ）返回到零件放置位置，电阻将悬浮

在光标上。 

8.按空格键以 90°为增量旋转组件，直至其具有正确的方向。 

9.将电阻放置在 Q1 基极的左侧（参见前面的示意图），然后单击鼠标左键或按 Enter 键放置零件。 

10.将另一个 100k 电阻器 R2 放置在 Q2 的基极右上方。当您放置第二个电阻时，代号将自动增加。 

11.通过单击鼠标右键或按 ESC 键退出零件放置模式。光标将恢复为标准箭头。 

12.其余两个电阻 R3 和 R4 的值为 1K，在 Explorer 面板中搜索合适的 1K 5％0805 电阻。 

13.此搜索将返回所有以 1K 开头的电阻，包括 1K1,1K2,1K3 等等。使用“资源管理器”面板中的“描

述”列来帮助找到 1K 电阻，单击搜索结果打开 1K 5％0805 电阻，然后右键单击并选择 Place。 

14.使用刚刚给出的步骤，将指示符设置为 R3，确认注释字段可见，并且选定的覆盖区模型为

RESC0805（2012）_N。 

15.将 R3 置于 Q1 的集电极正上方，然后将 R4 直接放置在集电极或 Q2 上方，如上图所示。 



16.右键单击或按 ESC 键退出零件放置模式。 

 

C 查找和放置电容器 

1.返回 Explorer 面板，搜索合适的 22nF 16V 0805 电容。搜索将返回一些潜在的电容器，点击项

目 CMP-1036-04042-1 在本设计中使用。 

2.右键单击所选电容器并从菜单中选择 Place。 

3.当电容器浮在光标上时，按 Tab 键打开属性面板。 

4.在面板的属性部分，输入代号 C1。 

5.确认注释字段的可见性控件设置为可见。 

6.确保足迹模型设置为 CAPC0805（2012）145_N。 

7.将所有其他字段保留为其默认值，然后单击暂停按钮（ ）返回零件放置位置，电容器将悬浮

在光标上。 

8.按空格键以 90°为增量旋转组件，直至其具有正确的方向。 

9.将电容器放置在晶体管上方，但低于电阻器（请参阅前面的示意图），然后单击鼠标左键或按

Enter 键放置零件。 

10.放置和放置电容器 C2。 

11.右键单击或按 Esc 键退出放置模式。 

 

D 查找并放置连接器 

1.返回资源管理器面板，搜索 2针垂直头部以找到合适的连接器。 搜索将返回一些潜在的标题，

从描述栏你会看到一些低调，有些是压配合的，有些是标准的通孔标题。 某些标题的引脚间距为

0.1 英寸（2.54 毫米），有些引脚间距为 2毫米。请注意，如果说明文字不完全可见，则可以将光

标悬停在其上以将整个文字显示在 工具提示。 

2.从列表中选择 CMP-1024-00327-1，右键单击它并从菜单中选择 Place。 

3.当标题悬浮在光标上时，按 Tab 键编辑属性并将标志符设置为 P1。 

4.放置标题前，按空格键将其旋转至正确的方向。 点击以将连接器放置在原理图上，如上图所示。 

5.右键单击或按 ESC 键退出零件放置模式。 

保存你的电路图（快捷键：F，S）。 

 

你现在已经放置了所有的组件。 请注意，上图中显示的组件间隔开，以便有足够的空间连接到每

个组件引脚。 这很重要，因为您不能将导线放置在针脚的底部以达到针脚之外的针脚。 如果你这

样做，两个引脚将连接到电线。 如果您需要移动组件，请单击并按住组件的主体，然后拖动鼠标

重新定位组件。 

 



组件定位提示 

•要重新定位任何对象，请将光标直接放置在对象上，单击并按住鼠标左键，将对象拖到新位置，

然后释放鼠标按钮。移动限制为状态栏上显示的当前捕捉网格，随时按下 G 快捷键可循环显示当

前捕捉网格设置。请记住，将组件放置在粗糙网格上很重要，例如 50 或 100mil。 

•您也可以使用键盘上的箭头键重新定位一组选定的电路图对象。选择对象，然后按住 Ctrl 键的

同时按下箭头键。按住 Shift 键以将对象移动当前捕捉网格的 10 倍。 

•使用鼠标移动物体时，网格也可以临时设置为 1，按住 Ctrl 键即可完成此操作。定位文字时使用

此功能。 

•在按下 G 快捷键时循环的网格在工具»Preferences（选项）对话框的“原理图 - 网格”页面中

定义。 “Preferences（选项)”对话框的“原理图 - 常规”页面上的“单位”控件用于选择测

量单位，在 Mils 或 Millimeters 之间进行选择。请注意，Altium 组件是使用英制网格设计的，如

果更改为公制网格，组件引脚将不再落入标准网格。因此，建议使用 Mils for Units，除非您计

划仅使用自己的组件。 

 

13.连接电路 

布线是在电路的各个组件之间建立连接的过程。 要连接您的电路图，请参阅下面显示的电路草图

和动画。  

动画见附件：SchematicWiring.gif 

 

活动栏 

每个编辑器中最常用的工具都可以在编辑窗口顶部显示的活动栏上找到。 



 

活动栏上的按钮可以是单功能或多功能。 多功能按钮由一个小三角形表示，单击并按住按钮上的

任意位置 1秒钟，会出现一个菜单，列出其他可用的命令。 最后使用的命令将成为该按钮位置的

默认值。 

 

连接原理图 

1.为确保您能够理解原理图表，请按下 PgUp 键放大或 PgDn 缩小。或者，按住 Ctrl 键并滚动鼠标

滚轮放大/缩小，或按住 Ctrl + Right Mouse 按钮并向上/向下拖动鼠标以放大/缩小。在右键单

击 View 子菜单中还有许多有用的 View 命令，例如 Fit All Objects（Ctrl + PgDn）。 

2.首先，按照以下方式将电阻器 R1 的下引脚连接到晶体管 Q1 的基极。单击活动栏上的按钮（放置

»导线）以进入导线放置模式。光标将变为十字线。 

3.将光标放在 R1 的底端。当你处于正确的位置时，光标位置会出现红色连接标记（大十字）。这

表示光标位于组件上的有效电气连接点上。 

4.单击鼠标左键或按 Enter 键确定第一个导线点。移动光标，你会看到一条电线从光标位置延伸到

锚点。 

5.将光标放在 Q1 的底部，直到您看到光标变为红色连接标记。如果导线以错误的方向形成一个角，

请按空格键切换角点方向。 

6.点击或按 Enter 将导线连接到 Q1 的基座。光标将从该线释放。 

7.注意光标保持十字形，表示您准备放置另一根电线。要完全退出放置模式并返回到箭头光标，

您需要右键单击或再次按 ESC - 但不要立即执行此操作。 

8.从 R3 的下引脚连接到 Q1 的集电极。将光标定位在 R3 的低位引脚上，然后单击或按 Enter 键以

开始新的连线。垂直移动光标直到它位于 Q1 的收集器上，然后单击或按 Enter 放置导线段。光标

再次从导线释放，并且您保持接线模式，准备放置另一根导线。 

9.如上面的动画所示，将其余的电路接通。 

10.完成放置所有电线后，右键单击或按 ESC 退出放置模式。光标将恢复为箭头。 

 

接线提示 

•左键单击或按 Enter 键将导线锚定在光标位置。 

•按 Backspace 键删除最后一个定位点。 

•按空格键切换拐角的方向。您可以在上面显示的动画中观察此情况，并在连接器接线时结束。 

•按 Shift +空格键循环接线角模式。可用的模式包括：90，45，任意角度和自动线（在点击点之

间放置正交线段）。 



•右键单击或按 Esc 退出导线放置模式。 

•单击并按住以移动放置的组件，或者按住 Ctrl 并单击并按住以将所有组件连同任何连接的电线一

起拖出。 

•按 Ctrl 键并单击并按住导线拖动导线，如上面的动画所示。 

•只要导线穿过组件的连接点，或者在另一导线上终止，则会自动创建一个连接点。 

•即使删除了连接点，穿过针脚末端的导线也会连接到该针脚。在继续之前，检查您的有线电路是

否如图所示。 

•如果需要，可以将接线交叉显示为小拱形，在“Preferences（选项）”对话框的“原理图 - 常

规”页面中启用该选项。 

 

14.添加网络标签 

网和网络标签 

现在你已经互相连接的每一组件引脚现在形成了所谓的网络。 例如，一个网络包括 Q1 的基极，R1

的一个引脚和 C1 的一个引脚。 每个网络会自动分配一个系统生成的名称，该名称基于该网络中的

某个组件引脚。 

 

为了便于在设计中识别重要的网络，可以添加网络标签来分配名称。 对于多谐振荡器电路，您将

在电路中标记 12V 和 GND 网络，如下所示。 

 

添加网络标签 

1.点击按钮 （放置»网络标签）。 网络标签将浮现在光标上。 

2.要在放置网标之前编辑网标，请按 Tab 键打开“属性”面板。 



3.在 Net 字段中键入 12V，然后单击暂停按钮（ ）返回到对象放置。 

4.放置网络标签，使其热点（左下角）接触原理图上最上面的导线，如下图所示。 当网络标签正

确定位以连接电线时，光标将变为红色十字。 如果十字线为浅灰色，则表示不会建立有效的连接。 

  

 

5.放置第一个网络标签后，您仍将处于网络标签放置模式，因此在放置之前再次按 Tab 键以编辑

属性面板中的第二个网络标签。 

6.在“网络名称”字段中键入 GND，然后按 Enter 键返回到对象放置模式。 

7.放置网络标签，使网络标签的左下角接触原理图中最下面的导线（如上面的完整原理图所示）。 

右键单击或按 ESC 退出网络标签放置模式。 

保存你的电路和项目。 

 

网络标签，端口和电源端口 

•除了赋予网名外，网络标签还用于在同一个原理图纸上的 2个独立点之间建立连接。 

•端口用于在不同工作表上的 2个独立点之间建立连接。 底片连接器也可以用来做到这一点。 

•电源端口用于在所有工作表上的点之间建立连接，因此可以使用网络标签或电源端口。 

 

恭喜！ 您刚刚完成了第一个原理图捕获。 在将原理图转换为电路板之前，需要配置项目选项，并

检查设计是否存在错误。 

 

15.设置项目选项 

项目特定设置在“PCB 项目选项”对话框中配置，如下所示（项目»项目选项）。 项目选项包括错

误检查参数，连接矩阵，类生成器，比较器设置，ECO 生成，输出路径和连接选项，多通道命名格

式，默认打印设置，搜索路径和项目级参数。 这些设置在编译项目时使用。 

 

可以从“文件和报告”菜单中设置项目输出，例如装配，制作输出和报告。 这些设置也存储在

Project 文件中，因此它们始终可用于此项目。 另一种方法是使用 OutputJob 文件来配置输出，

其优点是可以将 OutputJob 从一个项目复制到下一个项目。 查看更多关于输出以了解更多配置输

出。 

 



16.编译项目 

在 Altium Designer 中完成原理图后，编译它。这会生成设计的内部连接图，详细说明所有组件

和网络。在编制项目时，还应用综合设计和电气规则来验证设计。设计和规则检查在“PCB 项目选

项”对话框中进行配置。 

 

请参阅创建连接和编译和验证设计页面以了解更多信息。 

 

当所有错误得到解决后，通过生成一系列工程变更单（ECO），已编译的原理图设计已准备好转移

到目标PCB文档。这个过程的基础是一个比较器引擎，用于识别原理图设计和PCB之间的每个差异，

并生成一个 ECO 来解决每个差异。这种使用比较器引擎识别差异的方法意味着您不仅可以直接在原

理图和 PCB 之间工作（没有使用中间网表文件），还意味着可以使用相同的方法在任何阶段同步原

理图和 PCB 设计过程。比较引擎还允许您查找源文件和目标文件之间的差异并在两个方向上更新

（同步）。 ECO 生成和比较器也在“PCB 项目选项”对话框中进行配置。 

 

请参阅设计同步页面以了解更多信息。 

 

17.检查原理图的电气特性 

示意图不仅仅是简单的图 - 它们包含有关电路的电气连接信息。 您可以使用此连接意识来验证您

的设计。 编译项目时，软件将根据 Project for Project 对话框的错误报告和连接矩阵选项卡中

设置的规则检查错误。 编译项目时，检测到的任何违规都将显示在“消息”面板中。 

设置错误报告 

对话框页面：错误报告 

 

“项目选项”对话框中的“错误报告”选项卡用于设置大量的绘图和组件配置检查。 报告模式设

置显示违规严重程度的级别。 如果您想更改设置，请点击您希望更改的违例旁边的报告模式，然

后从下拉列表中选择严重性级别。 



 

 

设置连接矩阵 

对话框页面：连接矩阵 

 

设计编译时，每个网络中的引脚列表都内置在内存中。检测每个引脚的类型（例如：输入，输出，

被动等），然后检查每个网络以查看是否存在不应该彼此连接的引脚类型，例如连接到另一个输出

的输出引脚销。 “项目选项”对话框的“连接矩阵”选项卡用于配置允许哪些引脚类型相互连接。

例如，查看矩阵图右侧的条目并查找输出引脚。阅读矩阵的这一行，直到您进入 Open Collector Pin

列。它们相交的正方形是橙色的，表示在编译项目时，连接到原理图上开路集电极引脚的输出引脚

会产生错误状态。 

 

您可以使用单独的错误级别设置每种错误类型，例如。从没有报道，直到一个致命的错误。点击一

个彩色正方形来改变设置，继续点击移动到下一个检查级别。设置矩阵，使未连接的被动引脚产

生错误，如下图所示。 



 

连接矩阵定义了在原理图上检查哪些电气条件，请注意，未连接 - 被动引脚设置正在更改。 

 

更改连接矩阵 

1.要更改其中一个设置，请单击彩色框，它将循环显示 4种可能的设置。请注意，您可以右键单击

对话框的面部以显示一个菜单，该菜单允许您同时切换所有设置，包括将它们全部恢复到默认状态

的选项（如果您已切换设置并且不记得它们的默认状态，方便使用）。 

2.您的电路只包含无源引脚。让我们更改默认设置，以便连接矩阵检测未连接的无源引脚。向下看

行标签以找到被动引脚行。查看列标签以查找未连接。这些条目相交的正方形表示在原理图中发现

无源引脚未连接时的错误情况。默认设置为绿色，表示不会生成报告。 

3.单击此交点框，直到其变为黄色（如上图所示），以便在编译项目时为未连接的无源引脚生成警

告。您将在本教程后面故意创建此错误的实例。 

 

配置类生成 

对话页面：类生成 

 

“项目选项”对话框中的“类生成”选项卡用于配置设计生成的类别类型（然后使用“比较器和

ECO 生成”选项卡控制类是否传送到 PCB）。 默认情况下，软件将为每个原理图生成组件类和房间，

并为设计中的每个总线生成网络类。 对于像这样简单的单页设计，不需要生成组件类或房间 - 确

保“组件类”复选框被清除，这样做也会禁用为该组件类创建空间。 

 

请注意，该对话框的该选项卡还包含用户定义类的选项。 



 

“类生成”选项卡用于配置为设计自动创建的类和房间。 

 

配置类生成 

1.清除组件类复选框，如上图所示。 这将自动禁止为该原理图表创建展示空间。 

2.设计中没有总线，因此不需要清除位于对话框顶部附近的“为总线生成网络类”复选框。 

3.设计中没有用户定义的网络类（通过在网络上放置网络类指令完成），因此无需清除对话框选项

卡的用户定义的类区域中的生成网络类复选框。 

 

设置比较器 

对话框页面：比较器 

 

“项目选项”对话框中的“比较器”选项卡设置在编译项目时报告或忽略文件的差异。通常，只

需在此选项卡中更改设置时，就是在为 PCB 添加额外细节（如设计 规则）时，并且不希望在设计

同步期间删除这些设置。如果您需要更详细的控制，则可以使用单独的比较设置选择性地控制比较

器。 

 

对于本教程，只需确认“仅在 PCB 中定义的忽略规则”选项已启用即可，如下图所示。 



 

“比较器”选项卡用于精确配置比较引擎将检查的差异。 

 

配置比较器设置 

 

1.对于本教程，只需确认“仅在 PCB 中定义的忽略规则”选项已启用即可，如上图所示。 

 

您现在已准备好编译该项目并检查是否有错误。 

 

编译项目以检查错误 

主要文章：编译和验证设计 

 

编译项目会检查设计文档中的绘图和电气规则错误，并在“消息”面板中详细说明所有警告和错

误。 您已在“项目选项”对话框的“错误检查和连接矩阵”选项卡中设置了规则，因此现在可以

检查设计了。 

 

要编译项目并检查错误，请选择 Project»Compile PCB Project Multivibrator.PrjPcb。 



 

使用“消息”面板查找并解决设计警告和错误 - 双击警告/错误以定位到该对象。 

 

编译并检查错误 

 

1.要编译多谐振荡器项目，请选择 Project»Compile PCB Project Multivibrator.PrjPcb。 

2.编译项目时，所有警告和错误都显示在“消息”面板中。如果检测到错误（不是只有警告时），

面板只会自动出现，手动打开它，单击右下方的按钮，然后从菜单中选择消息。 

3.如果您的电路正确绘制，则“消息”面板不应包含任何错误，只会显示编译成功消息，找不到错

误。如果出现错误，请仔细检查每个电路，检查电路并确保所有接线和连接都正确。 

 

您现在会故意将一个错误引入电路并重新编译该项目： 

1.单击设计窗口顶部的 Multivibrator.SchDoc 选项卡，使原理图纸成为活动文档。 

2.点击连接 R1 到 Q1 基极线的导线中间。在导线的每一端都会出现小的方形编辑手柄，选择颜色将

沿着导线显示为虚线以指示它被选中。按键盘上的删除键删除电线。 

3.重新编译项目（Project»Compile PCB Project Multivibrator.PrjPcb）以检查错误。消息面板

将显示警告消息，指示您的电路中未连接引脚。 

4. Messages 面板被水平分割成 2个区域，如上图所示。上部区域列出所有消息;可以通过右键菜

单保存，复制，交叉探测或清除。较低的区域详细说明面板上部区域当前选择的警告/错误。 

5.当您在“消息”面板的任一区域中双击某个错误或警告时，原理图视图将平移并缩放到错误的对

象。 

 

在完成本教程的这一部分之前，让我们先修复原理图中的错误。 

1.使原理图纸成为活动文档。 

2.取消删除操作（Ctrl + Z），恢复删除的导线。 



3.要检查是否不再有任何错误，请重新编译项目（Project»重新编译 PCB 项目

Multivibrator.PrjPcb） - Messages 面板应该不显示错误。 

保存原理图和项目文件。 

 

当您在“消息”面板中双击一个错误时： 

•原理图缩放以显示错误的对象。 “缩放精度”（Zoom Precision）由“Preferences（选项）”

对话框的“System - Navigation(导航)”（System - Navigation）页面的“突出显示方法”（Highlight 

Methods）部分中的上滑块进行设置。 

•整个原理图都会消失，除了错误的对象外。 原理图淡入量由调光级别（Dimming level）控制，

由“Preferences（选项）”对话框的“System - Navigation(导航)”页面的“高亮显示方法”部

分中的下滑块设置。 点击原理图上的任意位置可清除调光。 

 

•要从“消息”面板中清除所有消息，请右键单击面板并选择全部清除。 

原理图捕捉现已完成，可以创建 PCB！ 

 

二、创建一个新的 PCB 

在将设计从原理图编辑器传输到 PCB 编辑器之前，您需要创建空白 PCB，然后将其命名并保存为项

目的一部分。 



 

 

添加新 PCB 到项目 

1. 可以通过“项目”面板的右键菜单将新 PCB 添加到项目中，选择添加新项目到 PCB»命令。 

2.如上所示，PCB 将在项目中显示为源文档。 右键单击“项目”面板中的 PCB 图标以选择“另存

为”命令，并将其命名为多谐振荡器。 请注意，您不需要在另存为对话框中输入文件扩展名，这

会自动添加。 

3.添加 PCB 改变了项目，所以也保存项目（右键单击项目面板中的项目文件名，然后选择保存项目）。 

 

配置板的形状和位置 

主要文章：The Board 

在从原理图编辑器传输设计之前，需要更改此空白板的许多属性，其中包括： 

 

设置原点：PCB 编辑器有两个起点，即工作区左下方的绝对原点和用户可定义的相对原点，用于确

定当前工作区的位置 - 状态栏上显示的坐标是相对的 到这个原点。 一种常用的方法是将相对原

点设置为电路板形状的左下角。 选择编辑»原点»设置命令设置相对原点，使用重置命令将其重置

回绝对原点。 

 

从英制单位改为公制单位:当前工作空间的 X / Y 位置和网格显示在状态栏上，状态栏显示在软件

底部。 对于本教程，将使用公制单位 - 更改单位，或者按下键盘上的 Q 键以在英制和公制单位

之间来回切换，或者从菜单中选择查看»切换单位命令。 

 

选择合适的捕捉网格:您将注意到当前捕捉网格为 0.127mm，这是旧的 5mil 英制捕捉网格，转换为

公制。 要随时更改捕捉网格，请按 G键显示捕捉网格菜单，您可以在其中选择英制或公制值。 请



注意菜单中显示的快捷方式，使用 Ctrl + Shift + G 打开“捕捉网格”对话框，当您想键入特定

值时，该对话框非常方便。 另一个有用的快捷方式是 Ctrl + G，用于打开笛卡尔网格编辑器，您

可以在其中将网格从点更改为线，并更改网格颜色。 本教程后面将更详细地讨论网格。 

将板子形状重新定义为所需的尺寸:板子形状由带有网格的黑色区域显示。 新电路板的默认尺寸

为 6x4 英寸，教程板为 30mm x 30mm。 下面提供了为板子定义新形状的过程的详细信息。 

 

配置设计中使用的层:除了走线的铜层或电子层外，还有通用机械层和特殊用途层，如组件叠层（丝

网印刷），阻焊层，粘贴掩膜和 等等。 电气和其他层将很快配置。 

随时按下 Ctrl + PgDn 进行缩放以显示整个电路板。 

 

设置原点和网格 

1.软件中使用两个起点，即工作区左下方的绝对原点和用户可定义的相对原点，用于确定当前工作

区的位置。 在设置原点之前，继续放大当前板形状的左下角，直到您可以轻松看到网格 - 执行此

位置，将光标放在板的左下角形状上，然后按 PgUp，直到粗略和 细网格是可见的，如下图所示。 

2.要设置相对原点，请选择编辑»原点»设置，将光标置于电路板形状的左下角，然后左键单击以

找到它。 

  

 

选择命令，将光标定位在电路板形状的左下角（左图）上，然后单击以定义原点（右图）。 

 

3.下一步是选择一个合适的捕捉网格，如上表所述。 在设计过程中，更换网格很常见，例如，在

组件放置期间可以使用粗糙的网格，并使用更精细的网格进行布线。 对于本教程，您将使用 Metric

网格。 一个粗糙的 5mm 网格适用于组件放置，按下 Ctrl + Shift + G 打开对齐网格对话框并输

入 5mm，然后单击确定关闭对话框。 

4.在输入值时输入单位，也指示软件切换到度量网格。 如果您查看状态栏，则可以确认网格现在

是公制。 

 



重新定义板的形状 

 

1.默认的电路板形状为 6x4 英寸，本教程的电路板尺寸为 30mm x 30mm。 

2.要缩小显示所有电路板，请从菜单中选择查看»适合电路板（Ctrl + PgDn）。 

3.电路板将完全填充 PCB 编辑器。 要操纵大小，您需要能够看到电路板的边缘，请使用 Ctrl + 

WheelRoll 进一步缩小或按 PgDn。 

4.下一步是改变板的形状。 要做到这一点，您必须进入电路板规划模式，选择查看»电路板规划

模式进行更改（快捷方式：按 1键）。 显示屏将改变，电路板区域现在将显示为绿色。 

5.现在您的选择是重新定义板的形状（再次绘制）或编辑现有的板形状。 对于简单的正方形或矩

形，编辑现有的电路板形状效率更高，从菜单中选择 Design»Edit Board Shape。 请注意，您必

须在电路板规划模式下才能使用此命令。 

 

对于这种设计，编辑现有的电路板形状效率更高。 这些命令仅在电路板规划模式下可用。 

 

6.编辑手柄将出现在每个拐角和每个边缘的中心，如下所示。 

注：点击除编辑手柄或形状边缘以外的任何位置都会使您退出棋盘形状编辑模式。 

 

7.目标是调整形状以创建一个 30 毫米×30 毫米的电路板。 粗糙的可视网格是 25 毫米（5倍捕捉

网格），精细可见网格是 5 毫米 - 这些可以用作指导。 您现在可以：将上边缘向下和右边缘滑入

以创建正确的大小; 或者移动拐角中的 3个，留下位于其当前位置的原点的拐角。 

8.要将上边缘向下滑动，请将光标放在边缘上（但不要放在手柄上），当光标变为双头箭头时单击

并按住，然后将边缘拖到新位置，以便 Y光标 状态栏上的位置为 30mm，如下图所示。 

9.重复该过程以移动右侧边缘，当状态栏上的 X光标位置为 30mm 时将其定位。 

注：使用状态栏左下方的当前位置信息来指导您重新塑造电路板。 



 

显示调整大小光标，使用状态栏上的位置信息来帮助您将板子调整为 30mm x 30mm。 

8.单击工作区中的任何位置以退出棋盘形状编辑模式。 

9.按 2 快捷键切换回 2D 布局模式。 

10.现在已经定义了形状，您可以将网格设置为适合组件放置的值，例如 1mm。 网格将在短期内详

细讨论。 

11.保存 PCB。 

 

电路板尺寸已被定义，单位，原点和网格已被设置。 所需的图层将很快配置。 

 

定义非矩形电路板形状的一个好方法是在 keepout 层上放置一系列轨道（以及弯曲电路板的弧）。 

除了可用作放置和布线保留屏障外，还可以选择这些轨道和圆弧（编辑»选择»全部图层），并使

用设计»电路板形状»从所选对象定义命令创建电路板形状。 

 



转移设计（原理图转移到 PCB） 

主要文章：在原理图和 PCB 之间工作 

 

设计直接在原理图编辑器和 PCB 编辑器之间传输，没有创建中间网表文件。从原理图编辑器中选择

Design»Update PCB Document Multivibrator.PcbDoc，或者从 PCB 编辑器中选择 Design»Import 

Changes from Multivibrator.PrjPcb。 

 

当您运行这些命令中的任何一个时，编译设计并创建一组工程变更单，其中： 

•列出设计中使用的所有组件，以及每个组件所需的占位面积。执行 ECO 时，软件将尝试在当前可

用的库或可用的 Altium Content Vault 中查找每个丝印，并将每个丝印放入 PCB 工作区。如果足

迹不可用，则会发生错误。 

•创建设计中所有网络（连接的组件引脚）的列表。当执行 ECO 时，软件会将每个网络添加到 PCB，

然后尝试添加属于每个网络的引脚。如果无法添加引脚，则会发生错误 - 这通常发生在没有找到

封装时，或者封装上的焊盘未映射到符号上的引脚。 

•然后传输附加设计数据，例如网络和组件类。 

 

 

 

一旦 ECO 执行完毕，组件将被放置在板子外部，并创建网络。 请注意默认指定符（和注释）字体

已被更改。 

 

在将原理图信息传输到新的空白 PCB 之前，请确保原理图和 PCB 的所有相关库都可用。 由于本教

程仅使用 Altium Content Vault，所需的 Vault 已经可用。 由于 Vault 包含符号和封装，因此本

教程所需的封装也可用。 

 



所有 PCB 对象的默认设置都可以在 Preferences 对话框的 PCB Editor - Defaults 页面中定义。 例

如，如果您希望所有 PCB 设计的组件指示符均为 1.5mm 高 Arial Truetype，请编辑指定符（和注

释）默认值。 

 

将设计从原理图捕获转移到 PCB 布局 

1.制作原理文件，Multivibrator.SchDoc，活动文件。 

2.从原理图编辑器菜单中选择设计»更新 PCB 文档 Multivibrator.PcbDoc。 该项目将编译并打开

工程变更单对话框。 

 

为每个需要对 PCB 进行的更改创建一个 ECO，以使其与原理图匹配。 

3.点击验证更改。 如果所有更改都得到验证，则状态列表中每个更改旁边都会显示绿色勾号。 如

果更改未通过验证，请关闭对话框，选中消息面板并解决所有错误。 

4.如果所有更改都经过验证，请单击执行更改将更改发送到 PCB 编辑器。 

5.完成后，打开目标 PCB 并在其上打开工程更改订单对话框，完成列条目将被打勾（如下图所示）。 

6.点击关闭对话框并完成传输过程。 

7.组件将被放置在电路板外部，准备放置在电路板上。 在开始组件放置过程之前，需要完成几个

步骤，例如配置放置网格，图层和设计规则。 

 

您可以通过单击报告更改按钮来创建 ECO 的报告。 

 

配置 PCB 工作区 

完成所有 ECO 后，组件和网络将出现在 PCB 工作区中，位于电路板轮廓的右侧，如上图所示。 

 



在开始在电路板上定位组件之前，您需要配置某些 PCB 工作区和电路板设置，例如层，网格和设计

规则。 

 

配置图层的显示 

面板页面：查看配置 

 

除了用于制作电路板的层（包括：信号层，电源层，掩膜层和丝印层）外，PCB 编辑器还支持许多

其他非电气层。这些图层通常按以下方式分组： 

•电气层 - 包括 32 个信号层和 16 个内部电源层。 

•机械层 - 有 32 个通用机械层，用于设计任务，如尺寸，制造细节，装配说明或特殊用途任务，

如胶点层。这些图层可以选择性地包含在打印和 Gerber 输出生成中。它们也可以配对，这意味着

当组件翻转到电路板的底部时，放置在库编辑器中成对层之一上的对象将翻转到对中的另一层。 

•特殊层 - 包括顶部和底部丝印层，焊接和粘贴掩膜层，钻孔层，Keep-Out 层（用于定义电气边

界），多层（用于所有信号层上存在的物体等作为焊盘和过孔），连接层，DRC 错误层，网格层，

孔层和其他显示类型层。 

 

所有图层的显示属性均在“查看配置”面板中配置。打开面板： 

•单击应用程序右下角的按钮 ，然后从菜单中选择查看配置，或者 

•选择查看»面板»查看配置菜单条目，或 

•按 L 快捷键，或 

•单击工作区左下方的当前图层颜色图标 。 



  

 

除了图层显示状态和颜色设置外，“查看配置”面板还允许访问其他显示设置，包括： 

•系统颜色的颜色和可见性，例如选择颜色，或者连接线是否可见（系统颜色）。 

•如何显示每种类型的对象（实体或草稿）及其透明度（对象可见性）。 

•各种查看选项，如要显示起点标记，填充网名称和填充数字（附加选项）。 

•当对象变暗或遮罩时（遮罩和暗淡设置），显示器变暗的量。 

•使用控件（图层）创建图层集，它提供了切换当前可见图层的快速方法。 

•创建和选择视图配置，用于预先配置所有图层属性，例如颜色，可见性，对象透明度等（常规设

置）。 

 



图层提示 

•当前启用的图层显示为 PCB 工作区底部的一系列选项卡。右键单击选项卡以访问常用的图层显示

命令。 

•在繁忙的设计中，它可以帮助仅显示当前正在处理的图层 - 按 Shift + S 快捷键切换显示进入/

退出单层模式。可用单层模式在“Preferences（选项）”对话框的 PCB 编辑器 - Board Insight 

Display 页面中进行配置。每按一次 Shift + S 将循环到下一个启用的单层模式。 

•切换活动层： 

单击图层选项卡或 

按+或 -键循环浏览所有图层或 

按*键循环显示信号层，或 

使用 Ctrl + Shift + WheelRoll 快捷键。 

 

配置图层可见性 

1.打开“视图配置”面板。 

2.在图层和颜色选项卡中，确认顶层和底层信号层是可见的。 

3.请注意，此面板是控制遮罩层，丝网层和系统层（如 DRC 和网格）显示的位置。 

4.为了在放置和布线期间减少视觉上的“杂乱”，请禁用 Mechanical 图层，焊接和粘贴蒙版图层

以及钻取指南和钻取图层的显示。 

5.切换到查看选项选项卡。 

6.确认焊盘网络和焊盘编号选项已启用。 

 

物理层和层堆栈管理器 

对话框页面：图层堆栈管理器 

 

除了信号层和电源层（固体铜层）之外，PCB 编辑器还包含阻焊层和丝网物理层 - 这些都是在制

作物理板期间使用的。这些层的布置被称为层堆叠。在图层堆栈管理器中配置图层堆栈，单击设计

»图层堆栈打开对话框。 

 

层堆栈管理器对话框用于： 

•添加/删除信号层和电源层。 

•添加/去除介质层。 

•更改图层的顺序。 

•配置物理层的物料类型。 

•设置层厚度，电介质材料和介电常数。 

•定义平面层的回拉量（从平面边缘到板边缘的间隙）。 

•为覆盖层定义覆盖层扩展。 



•定义该图层的组件方向（当存在嵌入组件时使用）。 

 

教程 PCB 是一个简单的设计，可以作为单面或双面电路板布线。下面显示的图层厚度已被编辑为使

用合理的度量值。 

 

物理层的属性在层堆栈管理器中定义。 

 

要编辑单元格，请执行以下操作：在单元格中双击; 或选择单元格，然后按 F2 键显示下拉列表或

编辑该值。 

 

配置板层堆栈 

1.打开层堆栈管理器。 对于新电路板，默认堆叠包括：电介质芯，2 个铜层，以及顶部和底部阻

焊层（覆盖层）和覆盖层（丝网）层，如上图所示。 

2.通过添加图层按钮或右键单击菜单，在当前选定的图层下添加新图层和平面。 

3.放置层堆叠表时，会包含层的属性，例如材料，铜厚度和介电属性，也可用于信号完整性分析。 

双击单元格以配置该设置。 例如，下图中显示的厚度设置稍微更改为更适合的度量值。 

4.完成配置图层堆栈选项后，将值恢复为上图中显示的值，然后单击确定关闭对话框。 

 

英制或公制网格？ 

 

下一步是选择适合放置和布线组件的网格。放置在 PCB 工作区中的所有对象都放置在当前捕捉网格

上。 

 

传统上，电网的选择是为了适应您计划用于电路板的元件引脚间距和布线技术 - 也就是说，磁道

需要的宽度以及磁道之间需要的间隙。基本思想是尽可能广泛地使用轨道和间隙，以降低成本并提



高可靠性。当然，追踪/清除的选择最终是由每个设计可以实现的结果驱动的，这取决于组件和布

线必须紧密捆绑以便让电路板放置和布线。 

 

随着时间的推移，组件及其引脚的尺寸急剧缩小，引脚间距也缩小。它们的组件尺寸和它们的引

脚间距已经从占主导地位的带有通孔引脚的英制转移到具有表面装配引脚的更常见的公制尺寸。

如果你正在开始一个新的电路板设计，除非有很强的理由，例如设计一个替代电路板以适应现有的

（英制）产品，那么你最好使用公制工作。 

 

为什么？ 

 

因为旧的帝国组件有很大的针脚，它们之间有很多空间。另一方面，小型表面安装器件采用公制测

量技术制造 - 它们是需要高度准确性以确保制造/组装/功能产品工作且可靠的产品。此外，PCB

编辑器可以轻松处理到离线引脚的布线，因此在公制电路板上使用英制组件并不麻烦。 

 

合适的网格设置 

对于这种简单的教程电路这样的设计，实际的网格和设计规则设置将是： 

 

Setting      Value     Where 

Routing width     0.25 mm    Routing Width design rule  

Clearance      0.25 mm    Electrical Clearance design rule  

Board definition grid   5 mm     Cartesian Grid Editor  

Component placement grid  1 mm     Cartesian Grid Editor  

Routing grid     0.25 mm    Cartesian Grid Editor  

Via size      1 mm     Routing Via Style design rule  

Via hole      0.6 mm     Routing Via Style design rule 

 

尽管选择一个非常好的走线网格可能会很诱人，因此走线可以有效地放在任何地方，但这不是一个

好方法。为什么？因为将网格设置为等于或小于轨道+间隙的一点是为了确保轨道被放置，以便它

们不会浪费可能的布线空间，如果使用非常细的网格，则会发生这种情况。 

 

 

选择视图»切换单位（或按 Q快捷键）在公制和英制之间切换工作空间单位。 

在打开的对话框或面板中，按 Ctrl + Q 切换该对话框或面板中所有测量的单位。 

无论单位的当前设置如何，您可以在对话框或面板中输入值时包括单位，以强制使用该值。 

 



支持多个网格 

Altium Designer 允许定义多个捕捉网格。有两种类型的网格支持，笛卡尔（传统的垂直/水平网

格）和极地（圆形网格）。 

 

除了定义网格类型外，还可以定义网格应用的区域。请注意，默认网格总是适用于整个工作区，即

使它仅显示在板形上。 

 

由于一次只能使用一个网格，所以网格也具有优先级，用于确定在重叠时应该应用哪个网格。还

有用于定义网格是用于所有对象，仅用于组件还是仅用于非组件的控件。 

 

网格在“属性”面板的“网格管理器”部分中创建和管理。使用面板上的按钮添加，编辑或删除

网格。 

 

本教程仅使用默认网格。 



 

 

网格管理器中可以配置多个网格，这 3个网格的图像显示在右侧（点击放大）。 

 

 



设置捕捉网格 

相关页面：网格管理器，笛卡尔网格编辑器，极坐标网格编辑器 

 

您可以通过按下来配置您需要用于教程的捕捉网格的值： 

•G 键显示捕捉网格菜单，您可以在其中选择英制或公制值（请注意菜单中显示的快捷方式） 

•Ctrl + Shift + G 键打开“捕捉网格”对话框 

•Ctrl + G 键打开笛卡尔网格编辑器对话框 

 

将捕捉网格设置为 1毫米，准备好放置组件。 

 

配置捕捉网格 

1.按下 Ctrl + G 快捷键打开笛卡尔网格编辑器对话框。 

2.在 Step X 字段中键入值 1mm。 由于 X和 Y字段已链接，因此不需要定义步骤 Y值。 

3.要使网格在较低缩放级别可见，请将乘数设置为 5x 网格步长，并且为了更容易区分两个网格，

请将细网格设置为显示为浅色点。 

4.单击确定关闭对话框。 

 

设置设计规则 

主要文章：PCB 设计规则参考 

 

PCB 编辑器是一个规则驱动的环境，这意味着当您执行更改设计的操作（如放置轨迹，移动组件或

自动布局电路板）时，软件会监控每个操作并检查设计是否仍然符合 设计规则。 如果没有，那



么该错误立即突出显示为违规。 在开始在电路板上工作之前设置设计规则，可以让您继续专注于

设计任务，并且有信心知道任何设计错误都会立即引起您的注意。 

 

设计规则在 PCB 规则和约束条件编辑器对话框中进行配置，如下所示（设计»规则）。 规则分为

10 类，然后可以进一步划分为设计规则类型。 

 

 

PCB 规则和约束条件编辑器中的所有 PCB 设计要求均被配置为规则/约束条件。 

 

走线宽度设计规则 

设计规则参考：宽度 

 

走线宽度由适用的走线宽度设计规则控制，软件在运行交互式走线命令并单击网络时自动选择。

在配置规则时，基本方法是设置最低优先级规则以定位最大数量的网络，然后添加更高优先级的

规则以定位具有特殊宽度要求的网络，例如电源网络。如果网络被多个规则作为目标，则不存在问

题，该软件始终查找并且仅应用最高优先级规则。 

 

例如，教程设计包括许多信号网和两个电源网。信号网络的默认走线宽度规则可以配置为 0.25mm。

通过将规则范围设置为全部，此规则将针对设计中的所有网络。尽管All的范围也针对Power网络，

但可以通过添加第二个更高优先级的规则来针对这些网络，其范围为 InNet（'12V'）或 InNet

（'GND'）。下图显示了这两个规则的摘要，详细信息显示在以下两个可折叠部分的图像中。 



 

已经定义了两个走线宽度设计规则，最低优先级规则针对所有网络，较高优先级的规则针对 12V

网络或 GND 网络中的对象。 

 

走线宽度和走线通过样式设计规则包括最小值，最大值和首选值设置。如果您希望在布线过程中

具有一定的灵活性，例如当您需要缩小路径时使用这些元件，或在电路板的狭小区域使用较小的通

路时，请使用这些元件。这可以在走线时通过按Tab键打开对话框并访问宽度/通过属性，或按Shift 

+ W 选择一个备用走线宽度并按 Shift + V 选择一个备用通路尺寸。请注意，如果您输入的值大于

或小于适用的设计规则允许的值，则您将始终受设计规则的约束，因此会将其裁剪为最接近的规则

值。 

 

避免使用“最小值”和“最大值”设置来定义单个规则以适应整个设计中所需的所有大小，这意味

着您放弃让软件监控每个设计对象的大小适合其任务的能力。 

 

为信号网络配置走线宽度规则 

1.将 PCB 作为活动文档，打开 PCB 规则和约束条件编辑器。 

2.每个规则类别显示在对话框的设计规则文件夹下（左侧）。双击“走线”类别以展开类别并查

看相关走线规则。然后双击宽度以显示当前定义的宽度规则。 

3.在现有宽度规则上单击一次以选择它。当您点击规则时，对话框的右侧将显示该规则的设置，包

括：规则的第一个对象与顶部部分匹配的位置（也称为规则的范围 - 您希望此规则的目标是什么）;

规则的约束条件在下面。 

4.由于此规则是针对设计中的大多数网络（信号网），请确认“第一个对象匹配的位置”设置设

置为“全部”。一个额外的规则将被添加到目标的权力网。 



5.编辑最小宽度，首选宽度和最大宽度值，将它们设置为 0.25mm。请注意，设置反映在对话框底

部显示的各个图层中，您还可以基于每层配置要求。 

6.现在定义规则，单击应用保存它并保持对话框打开。 

 

默认的走线宽度设计规则已配置。 

 

为电源网络添加走线宽度规则 

1.下一步是添加另一个设计规则来指定电源网络的布线宽度。要添加和配置此规则，请打开 PCB

规则和约束条件编辑器。 

2.在对话框左侧的设计规则树中选择现有宽度规则，右键单击并选择新规则以添加新的宽度约束规

则，如下面的动画所示。 

3.出现一个名为 Width_1 的新规则。点击设计规则树中的新规则来配置其属性。 

4.单击右侧的名称字段，并在字段中输入名称 Width_Power。 

5.点击查询生成器按钮打开查询生成器，将其配置为目标对象：InNet（'12V'）或 InNet（'GND'）。 

最后一步是为规则设置约束条件。编辑最小宽度/首选宽度/最大宽度值 0.25 / 0.5 / 0.5，以允

许电源网布线宽度在 0.25mm 至 0.5mm 的范围内，如下所示。 



 

动画见附件：DesignRules_Power_AD18.gif 

此宽度规则以电源网为目标。 

 

8.单击应用保存规则并保持对话框打开。 

当存在多个相同类型的规则时，PCB 编辑器使用规则优先级来确保应用最高优先级适用规则。 

 

什么时候： 

•添加新规则时，会给予最高优先级，以及何时 

•规则被复制时，副本在源规则下被赋予优先级。 

 

单击对话框底部的优先级按钮以更改优先级。 

 

定义电气间隙约束 

设计规则参考：清除约束 

 

下一步是定义属于不同网络的电气物体彼此之间的接近程度。 

这个要求由电气间隙约束来处理，对于本教程，所有物体之间的间隙为 0.25mm 是合适的。 

 

请注意，在最小间隙字段中输入值将自动将该值应用于对话框底部网格区域中的所有字段。 当需

要根据对象类型定义间隙时，只需在网格区域中进行编辑。 



 

电气间隙约束是在物体之间定义的。 将约束切换到高级以显示所有对象类型。 

 

请注意，电气间隙约束有两个对象选择字段，第一个对象匹配和第二个对象匹配的位置。 这是因

为这是一个二元规则 - 这是一个适用于两个对象之间的规则。 

定义电气间隙约束 

1.在设计规则树中展开 Electrical 类别，然后展开 Clearance 规则类型。 

2.单击以选择现有的间隙约束。 请注意，此规则有两个完整查询字段，这是因为它是一个二进制

规则。 规则引擎检查第一个对象匹配的设置所针对的每个对象，并根据第二个对象匹配设置所在

的对象对其进行检查，以确认它们满足指定的约束设置。 对于此设计，此规则将被配置为定义所

有对象之间的单个间隙。 

3.在对话框的约束区域中，将最小间隙设置为 0.25mm，如上图所示。 

4.点击应用保存规则并保持对话框打开。 

 

通过样式定义走线 

设计规则参考：通过样式进行走线 

 

在走线和更改图层时，会自动添加过孔，在此情况下，通孔属性由适用的走线通过样式设计规则

定义。 如果您从放置菜单放置过孔，则其值由内置的默认基元设置定义。 对于本教程，您将配置

Routing Via Style 设计规则。 



 

单个走线过孔适用于此设计中的所有网络。 

 

走线过孔样式设计规则定义 

 

1.展开设计规则树并选择默认的 RoutingVias 设计规则。 

2.由于电源网极有可能在电路板的单面布线，所以不需要通过信号网络的样式规则来定义走线，而

通过电源网络的样式规则来定义另一走线。 将规则设置编辑为本教程前面建议的值，即 Via 

Diameter = 1mm 和 Via Hole Size = 0.6mm。 将所有字段（最小，最大，首选）设置为相同大小。 

3.单击确定关闭 PCB 规则和约束条件编辑器。 

4.保存 PCB 文件。 

 

现有的设计规则违规 

 

您可能已经注意到晶体管焊盘表明存在违规。 右键单击违例并在右键菜单中选择违规，如下所示。 

细节表明，有一个： 

•违反清除约束 

•MultiLayer 上的 Pad 和 MultiLayer 上的 Pad 之间 



•间隙为 0.22mm，小于规定的 0.25mm

 

右键点击违规行为，查看违规情况和违规情况。 在该图像中，显示器处于单层模式，顶层作为活

动层。 

 

这一违规行为将在短期内讨论并予以解决。 如果发现违规标记让人分心，可以通过运行“工具»

重置错误标记”命令来清除它们。 此命令只会清除标记，它不会隐藏或删除实际的错误。 下次

执行运行在线 DRC 的编辑操作（如移动组件）或运行批量 DRC 时，该错误将再次被标记。 

 

查看设计规则 

由软件创建的默认新电路板将包含在每个设计中不需要的规则，并且需要调整许多其他设计规则以

适应您的设计要求。 出于这个原因，检查设计规则是非常重要的。 这可以在 PCB 规则和约束条件

编辑器中完成，选择左侧树顶部的设计规则，然后可以查看所有规则的属性列，并快速找到需要调

整其值的任何值。 

 

默认电路板也使用英制单位，如果您的电路板使用公制，那么将会有许多规则值，例如焊片扩展，

将从 4mil 等四舍五入变为 0.102mm，或者最小阻焊掩膜银条默认值将从 10mil 到 0.254mm。 尽管

最不重要的数字（例如 0.002mm）在产生输出时不重要，但如果它困扰您，则可以在设计规则中编

辑这些设置。 



 

查看设计规则，注意如果需要可以更改列顺序。 

 

禁用冗余规则 

当您创建新的电路板时，它将包含可能不需要用于您的设计的默认设计规则。 例如，当您创建一

块新电路板时，会包含组装和制造测试点类型设计规则，而在此设计中不需要这些规则。 

1.如果未打开，请打开 PCB 规则和约束条件编辑器。 

2.单击测试点类别，并禁用 4个测试点类型规则（清除启用列中的复选框）。 如果没有这样做，

你会在本教程的后面看到违反测试点的情况。 

 

设计规则也可以导出并存储在.RUL 文件中，然后导入到未来的 PCB 设计中。 为此，请右键单击

PCB 规则和约束编辑器左侧的树中打开“选择设计规则”对话框。 使用标准的 Windows 选择技术

选择您希望导出的规则，然后单击确定导出选定的规则。 

 

将组件放置在 PCB 上（布局） 

有一种说法是 PCB 设计是 90％放置和 10％布线。 虽然你可以争论每一个的百分比，但普遍认为

良好的元件布局对于良好的电路板设计至关重要。 请记住，您也可能需要根据路线调整展示位置。 

 

组件定位和放置选项 

当您单击并按住组件以移动组件时，如果启用了对齐中心选项，则该组件将移动到由其参考点保持。 

参考点是组件的 0,0 坐标，当它在库编辑器中生成时。 



 

智能组件捕捉选项允许您覆盖此捕捉到中心的行为，并捕捉到最近的组件焊盘，而非需要将特定焊

盘放置在特定位置时使用。 

 

启用对齐到中心以始终按组件的参考点。当您需要通过特定的打击垫对齐时，Smart Component Snap

很有用。 

 

设置组件定位选项 

1.单击位于应用程序右上角的图标 ，打开“Preferences（选项）”对话框。 

2.打开对话框的 PCB 编辑器 - 常规页面，在编辑选项部分，确保已启用对齐中心选项。这确保了

当你“抓取”一个组件来定位它时，光标将通过它的参考点来保存该组件。 

3.注意智能组件捕捉选项，如果启用了此选项，则可以通过单击选中单击点位置最近的组件。如果

你需要一个特定的焊盘，这是非常方便的，在一个特定的网格点。如果你正在使用小型表面贴装元

件，它可以对付你，因为它可以使它更难以通过参考点“抓住”它们。 

 

放置组件 

您现在可以将组件放置在电路板上合适的位置。 

 

要移动组件，可以： 

•单击并按住组件上的鼠标左键，将其移动到所需位置，使用空格键旋转它，然后释放鼠标按钮以

放置它; 要么 

•运行编辑»移动»组件命令，然后单击以拾取组件，将其移动到所需的位置，如果需要则旋转，然

后单击一次将其放置。 完成后，右键单击以退出移动组件命令。 



 

在移动组件时，连接线会自动重新优化 - 使用它们来帮助定位和放置组件，从而减少连接线交叉

的数量。 

 

定位组件 

1.放大以显示电路板和组件。一种方法是缩小（PgDn），使板和组件全部可见，然后选择 View»View 

Area，然后单击以定义您希望查看的确切区域的左上角和右下角。 

2.组件将位于当前的捕捉网格上。对于这样简单的设计，没有具体的设计要求来决定应该使用什么

布局网格，作为设计者，您决定什么是合适的布局网格。为了简化定位组件的过程，您可以使用粗

略的放置网格，例如 1mm。检查状态栏以确认 Snap Grid 设置为 1mm，按 Ctrl + Shift + G 可根据

需要更改网格。 

3.本教程中的组件可以如上图所示放置。要放置连接器 P1，请将光标置于连接器轮廓的中间，然

后单击并按住鼠标左键。光标将变为十字线并跳转到零件的参考点。在继续按住鼠标按钮的同时，

移动鼠标拖动组件。 

4.如果需要，按空格键旋转组件，并将占位面朝向电路板的左侧，如上图所示。 

5.当连接器组件就位时，松开鼠标按钮将其放置到位。请注意连接线如何与组件拖动。 



6.使用上图作为参考重新定位其余组件。拖动它们时，使用空格键旋转（逆时针递增 90º）组件，

以便连接线如图所示。 

7.组件文本可以以类似的方式重新定位 - 单击并拖动文本并按空格键旋转它。 

8. PCB 编辑器还包含交互式布局工具。这些可用于确保四个电阻器正确对齐和间隔。 

9.按住 Shift 键，点击四个电阻中的每一个来选择它们，或者点击并拖动四个电阻的选择框。将

在每个选定组件周围显示阴影选择框，选择颜色在“视图配置”面板的“系统颜色”部分中定义。 

10.右键单击任何选定的组件，然后选择对齐»对齐以打开对齐对象对话框。 

11.在“水平”部分和“垂直”部分的“底部”中选择空间，然后单击“确定”以应用这些更改。

现在四个电阻对齐（最低组件）并且间隔相等。 

 

 

选择，然后对齐并隔开电阻。 

12.单击设计窗口中的其他地方取消选择所有电阻。 如果需要，您还可以对齐电容和晶体管，但这

可能不是必需的，因为此时您有一个粗糙的对齐网格。 

13.保存 PCB 文件。 

 

所选对象也可以使用键盘而不是鼠标移动。 要做到这一点，请按住 Ctrl 键，然后每次按下箭头

键时，选择将沿箭头方向移动 1格。 包含 Shift 键以 10x Snap Grid 步骤移动选定对象。 

 



使用鼠标移动组件时，可以通过按住 Alt 键将其限制为一个轴。 该组件将尝试保持相同的水平轴

（如果水平移动）或垂直轴（如果垂直移动） - 将其从轴进一步移开以覆盖此行为，或释放 Alt

键。 

 

布局完成，即可走线！ 

 

交互布线电路板 

主条目：交互式走线 

 

走线是在电路板上铺设线路和过孔以连接组件引脚的过程。 PCB 编辑器通过提供复杂的交互式走

线工具以及 ActiveRoute，使得这项工作变得简单易行，并通过点击按钮来优化走线所选连接。 

 

在本教程的这一部分，您将手动走线整个电路板单面，所有线路在顶层。交互式走线工具以直观

的方式帮助最大限度地提高走线效率和灵活性，包括线路放置的光标引导，连接的单击走线，推

送障碍物，自动跟随现有连接，所有这些都符合适用的设计规则。 

 

准备交互式走线 

主要文章：PCB 编辑器 - 交互式走线 

 

在开始走线之前，配置“Preferences（选项）”对话框的 PCB 编辑器 - 交互式走线页面中的交互

式走线选项非常重要。 



 

配置交互式走线选项。 

 

准备交互式走线 

1.设置走线冲突解决方案当前模式在第一个障碍时停止。在走线时，您可以通过按 Shift + R 键

循环启用模式。 

2.在页面的“交互式走线选项”部分中，确认启用了“自动终止走线”和“自动删除循环”选项。

第一个选项在您点击一个平板来完成该路线时从当前路线释放光标。第二个选项允许您通过简单地

走线备用路径来更改现有走线 - 走线新路径直到遇到旧路径（创建一个循环），然后右键单击以

指示它已完成 - 然后软件自动删除旧路径，走线的冗余部分。该功能将在本教程的后面部分进行

探讨。 

3.确认交互式走线宽度/过孔大小源选项都设置为规则优先。 

4.按 Ctrl + Shift + G 打开“捕捉网格”对话框并将“捕捉网格”设置为 0.25mm。 

 



将捕捉网格设置为适合布线的值。按下 Ctrl + Shift + G 打开“捕捉网格”对话框并将“捕捉网

格”设置为 0.25mm。 

 

交互式走线 

通过单击“走线”按钮或选择走线命令走线交互式走线（快捷键：Ctrl + W）来启动交互式走线。 

由于组件大多是表面贴装，设计简单，所以可以将电路板布置在顶层。 当您将轨道放置在电路板

的顶层时，您可以使用鼠标（连接线）来指导您。 

PCB 上的线走线一系列直线段组成。 每次方向改变时，都会开始一个新的线段。 此外，默认情况

下，PCB 编辑器将线路限制为垂直，水平或 45°方向，使您可以轻松制作出专业效果。 此行为可

以根据您的需求进行自定义，但对于本教程，您可以使用默认值。 

当走线到达目标板时，软件将自动释放该连接 - 您将保持交互走线模式，准备点击下一个连接线。 

 

http://www.altium.com/documentation/sites/default/files/wiki_attachments/296837/Inter

activerouting2.mp4 电驴可下载（已下载见附件） 

 

一个简单的 PCB 布线动画。请注意，许多连接都是使用 Ctrl +点击自动填充功能完成的。 

 

电路板交互布线 

1.通过查看工作区底部的图层选项卡，检查当前哪些图层可见。如果 Bottom Layer 不可见，请按

L 快捷键打开 View Configuration 面板，并启用 Bottom Layer。 

2.单击工作区底部的“顶层”选项卡，使其成为当前或活动层，随时可以进行走线。 

3.在单层模式下走线通常更容易，按 Shift + S 切换进入和退出单层模式。 

4.单击活动栏上的按钮（Ctrl + W 快捷方式），或从路径菜单中选择交互式走线，或右键单击并

从上下文菜单中选择交互式走线。光标将变为十字线，表示您处于交互式走线模式。 

5.将光标放在连接器 P1 上的下方焊盘上。当您将光标移动到接近焊盘时，它会自动捕捉到焊盘的

中心 - 这是“捕捉对象热点”功能，将光标拉到最近的电气对象的中心（在“捕捉选项”部分配

置“捕捉距离”属性面板）。有时，“捕捉对象热点”功能会在您不需要时拉动光标，在这种情况

下，请按 Ctrl 键暂时禁止该功能。或者，使用 Shift + E 快捷键循环浏览三种可能的状态（所有

图层/当前图层/关闭）。当前模式显示在状态栏上。 

6.左键单击或按 Enter 键确定轨道的第一个点。 

7.将光标移向电阻 R1 的下方焊盘，然后单击以放置垂直段。请注意轨道段如何以不同的方式显示

（如下图所示）。在走线过程中，分段显示为： 

Solid - 已放置分段。  

Hatched-采用带阴影的线段，但未提交，当您左键单击时将放置它们。 

http://www.altium.com/documentation/sites/default/files/wiki_attachments/296837/Interactiverouting2.mp4
http://www.altium.com/documentation/sites/default/files/wiki_attachments/296837/Interactiverouting2.mp4


Hollow - 这被称为先行段，它可以让你确定最后建议的段应该结束的位置。点击时不会放置此段，

除非下一次点击才会完成路线。在这种情况下，“自动终止走线”选项将启用并覆盖默认的预查

行为。在走线期间，可以使用 1 快捷键方式打开/关闭预读模式。 

 

请注意段的显示方式有所不同。 

 

8.通过左键单击手动走线来提交轨道段，在 R1 的下部键盘完成。请注意每次点击鼠标放置阴影线

段的方式。对于您当前正在布线的连接，请按 Backspace 以拆分最后放置的段。 

9.您也可以按 Ctrl +左键单击以使用自动完成功能并立即走线整个连接，而不是一直走线到目标

板。自动完成的行为方式如下： 

○采用最短路径，这可能不是最佳路径，因为您始终需要考虑其他连接尚未走线的路径。如果

您处于推送模式（走线时显示在状态栏上），则自动完成可以推送现有路线以到达目标。 

○长连接时，自动完成路径可能并不总是可用，因为走线路径是逐节映射的，并且可能无法完

成源和目标焊盘之间的映射。 

○您也可以直接在焊盘或连接线上自动完成。 

10.继续走线板上的所有连接。 

11.使用上面详述的技术来走线板上其他组件之间的所有连接。上面的简单动画显示了交互式走线

板。 

12.没有单一的解决方案来布线电路板，所以你不得不改变走线。 PCB 编辑器包含帮助完成这些操

作的功能和工具，这些将在以下各节中进行讨论，并在上面的动画中进行演示。 

13.完成走线时保存设计。 

 



走线技巧 

在走线时请记住以下几点： 

按键     功能 

~ or  Shift+F1    

弹出一个交互式快捷方式菜单 - 大多数设置可以通过按下相应的快捷方式或从菜单中进行选择来

实时更改。 

 *  or  Ctrl+Shift+WheelRoll   

切换到下一个可用的信号层。 根据适用的 Routing Via Style 设计规则自动添加通孔。 

Shift+R 

循环启用冲突解决模式。 在交互式走线 Preferences（选项）页面中启用所需的模式。 

Shift + S 

打开和关闭单层模式 - 当多个图层上有许多对象时是理想选择。 

空格键 

切换当前拐角的方向。 

Shift +空格键 

循环播放各种轨道拐角模式。 样式是：任意角度，45°，45°弧形，90°和 90°弧形。 可以在

交互式走线偏好设置页面中将此限制为 45°和 90°。 

Ctrl +左键单击 

自动完成正在走线的连接。 如果存在与障碍物无法解决的冲突，则自动完成将不会成功。 

Ctrl 

临时挂起热点捕捉，或按 Shift + E 循环选择 3种可用模式（关闭/打开当前图层/打开所有图层）。 

End 

重新绘制屏幕。刷新 



PgUp / PgDn 

放大/缩小，以当前光标位置为中心。 或者，使用标准的 Windows 鼠标滚轮缩放和平移快捷键。 

Backspace 

删除最后提交的轨道片段。 

右键单击或 ESC 

删除当前连接，保持交互式走线模式。 

 

注意状态栏，它在交互式走线期间显示重要信息，包括： 

•当前工作空间位置和“捕捉网格”设置 

•热点捕捉：关闭/打开当前图层/打开所有图层 

•当前轨道转角模式 

•当前交互式走线模式 

•走线宽度的来源 

•走线 Via Style 的来源 

•当前光泽强度 

•网名 

•总体路线长度 

•放置线段的尺寸 

 

交互式走线模式 

PCB 编辑器的交互式走线引擎支持多种不同的模式，每种模式都可帮助设计人员处理特定情况。按

Shift + R 快捷键在交互式走线中循环这些模式，注意当前模式显示在状态栏上。 

 

可用的交互式走线模式包括： 

•忽略障碍物 - 此模式可让您将轨道放置在任何地方，包括覆盖现有物体，显示但允许潜在的违

规。 

•停在第一个障碍物 - 在此模式下，路线基本上是手动的，一旦遇到障碍物，轨道线段将被剪切

以避免违规。 

•绕行障碍物 - 此模式将尝试在现有障碍物周围找到路线路线，而不尝试移动它们。 

•先绕行障碍物和无空间再推挤- 此模式是 Walkaround 和 Push 的组合。它会在执行绕行障碍时拥

抱，但是，当没有足够的间隙继续使用绕行时，它也会尝试推动固定的障碍物。 

•推挤障碍物 - 此模式将尝试移动能够在不违规的情况下重新定位的物体（轨道和过孔），以适

应新的路线。 



•当前层自动走线 - 此模式为交互式走线带来了基本的自动走线功能，它可以基于考虑推距的启

发式算法与步行距离和走线长度之间的自动选择。与自动布线器一样，此模式可以在复杂忙碌的电

路板上提供更好的结果，而不像简单的未布线的电路板上。 

•多层自动布线 - 此模式还为交互布线带来了基本自动布线功能，它还可以根据考虑推距的启发

式算法与步行距离和布线长度自动选择绕行和推挤。该模式也可以放置通路并考虑使用其他走线

层。与自动布线器一样，此模式可以在复杂忙碌的电路板上提供更好的结果，而不像简单的未布线

的电路板上。 

 

修改和重选现有路线 

要修改现有路线，有两种方法：重新走线或重新调整。 

 

重新选择现有的路线 

•不需要取消走线连接以重新定义路径，只需单击走线按钮并开始走线新路径。 

•关闭循环并右键单击以指示您已完成（循环删除功能在本教程前面启用）后，循环删除功能将自

动删除所有冗余磁道段（和过孔）。 

•您可以随时启动和结束新的路径路径，根据需要交换图层。 

•您也可以通过切换到忽略障碍模式（如下面的动画所示）来创建临时违规，稍后解决。 

 

动画见附件：Reroute2.gif 

一个简单的动画，显示用于修改现有走线的循环删除功能。 



 

在“Preferences（选项）”对话框的“PCB 编辑器 - 交互式走线”页面中启用“回路移除”。 请

注意，有些情况下可能需要创建回路，例如电源网络走线。 如有必要，可以通过编辑 PCB 面板中

的网络来禁用单个网络的回路去除。 要访问该选项，将面板设置为网络模式，然后双击面板中的

网络名称以打开编辑网络对话框。 

 

在回路移除过程中，您会发现返回到现有走线但尚未完成定义新路径的情况。 当启用“自动终止

走线”选项时，只要新走线覆盖现有走线，走线过程将终止，旧的冗余走线将被删除。 在这种情

况下，禁用“自动终止走线”选项可能更有效。 

 

重新调整现有路线 

•要以交互方式在整个电路板上滑动或拖动线段，只需单击，按住并拖动，如下面的动画所示。 默

认的拖动行为是在“Preferences（选项）”对话框的“PCB - 交互式走线”页面中配置的，如下

面的动画所示。 

•PCB 编辑器将自动保持 45/90 度的连接片段，根据需要缩短和延长它们。 

动画见附件：TrackSliding.gif 

 
显示轨道拖动的动画用于整理现有路线。 

 



跟踪拖动提示 

•使用“Preferences（选项）”对话框的 PCB 编辑器 - 交互式走线页面中的未选择通孔/轨道和选

定通孔/轨道选项更改默认的选择然后拖动模式。 

•拖动线段时，冲突解决模式也适用（忽略，推送，Hug&Push），按住 Shift + R 在拖动轨道段时

循环浏览模式。 

•如果启用了推送模式，现有焊盘和过孔将被跳过，或者必要时可能会推动过孔。 

•要将 90 度转角转换为 45 度路线，请开始拖动角点顶点。 

•拖动时，您可以将光标和热点对齐到现有的不移动对象（如上图所示） - 使用此对象帮助将新分

段位置与现有对象对齐，并避免添加非常小的分段。 

•要打断单个线段，首先选择线段，然后将光标放在中心顶点上以添加新线段。 

动画见附件：TrackSliding_Multiple.gif

 

通过将走线选择冲突模式设置为 Push 来拖动多个轨道的示例。 

 

ActiveRoute - 自动交互走线 

主要文章：ActiveRoute 

 

另一种在你的主板上布线的方法是使用 Altium 的自动交互式走线器。 

 

那是什么意思？这意味着您选择的连接线、网络和图层都自动交互式走线。 ActiveRoute 具有高

效的多网走线算法，它们被应用到您选择的特定网络或连接线。 ActiveRoute 还允许设计者自定

义交互式走线路径或向导进行走线。 

  

ActiveRoute 是为使用高引脚数组件的高密度板开发的，以帮助加速可能是困难和耗时的布线过程。

这块电路板不是它设计的电路板，但它提供了展示和查看其使用的机会。 



 

使用 ActiveRoute 走线 

•ActiveRoute 配置并从 PCB ActiveRoute 面板运行，如下图所示。 

•ActiveRoute 不会切换图层，它会尝试在 PCB ActiveRoute 面板中启用的图层上创建单层 pad-pad

和 pad-via 走线。在尝试 ActiveRoute 网络之前，高引脚数组件必须散开。 

•ActiveRoute 尝试走线选定的 pad / via / connection / net / nets。使用以下技术选择连接

线和网络： 

◦将 PCB 面板设置为网络模式，启用面板顶部的选择复选框并单击网络名称以选择该网络（不

是名称旁边的复选框，即用于为该网络启用 Board Insight Color Override 功能）。使用标准

Windows 快捷方式进行多选。 

◦在工作区中交互选择连接线 - Alt +左键单击 - 从右向左拖动。按住 Alt 并从右向左拖动绿

色选择窗口。绿色选择窗口触及的任何连接线将被选中。按住 Shift 键继续选择其他连接。 

◦左键单击以选择单个焊盘。 

◦在组件中选择多个焊盘 - Ctrl +左键单击 - 拖动。按住 Ctrl 并单击并拖动选择窗口，以选

择组件中的多个焊盘。从左向右拖动进行选择，从右向左拖动以选择触摸。 

 

•在 PCB ActiveRoute 面板中启用走线层。 

 

准备用于查看 ActiveRoute 的教程板。 

 

查看 ActiveRoute 

1.打开 PCB ActiveRoute 面板（ »PCB ActiveRoute）。 

2.打开 PCB 面板。 



3.在面板顶部的下拉菜单中选择网络模式，并启用选择复选框。 

4.布告板（Route » Unroute » All）。 

5.在面板中的网络列表中，单击 12V 网络名称。 

6.在 PCB ActiveRoute 面板中，启用顶层。 

7.点击面板顶部的 ActiveRoute 按钮，12V 网络将被走线。 

8.点击 PCB 面板上的 GND 网络，然后点击 ActiveRoute 按钮。如果您想使用 Shift + A 快捷方式

ActiveRoute，您必须在使用面板后单击工作区中的一次。这会使工作区成为软件中的主动元素，

否则软件将尝试将快捷方式解释为面板指令。 

9.点击面板上的 NetC2_1，然后点击 ActiveRoute 按钮。 

10.在面板上点击 NetC1_1。如果现在单击 ActiveRoute 按钮，则此网络将不会完全走线，因为连

接线的默认模式不是最佳模式。虽然可以通过定义手动 From-Tos 来重新排列连接线，但更简单的

方法是提倡通过取消选择整个网络并交互地选择仅仅 R1 的上方焊盘来尝试不同的模式进行

ActiveRoute。现在点击 ActiveRoute 按钮，这次这个网络中的两个连接都应该走线。 

11.点击面板上的 NetC1_2，然后点击 ActiveRoute 按钮。 

12.点击面板上的 NetC2_2，然后点击 ActiveRoute 按钮。 Q2 和 C2 之间的连接应该走线，但 Q2

和 R2 之间的连接可能会失败。为了走线此连接，您需要交互式地从 Q2-2 向上走线一小段线路。没

有必要创建任何拐角，一个短的直线段应该是足够的。

 

ActiveRoute 结果。 

 



 

验证您的电路板设计 

主要文章：PCB 设计规则参考 

 

PCB 编辑器是一个规则驱动的电路板设计环境，您可以在其中定义多种可以检查的设计规则，以确

保电路板的完整性。通常情况下，您可以在设计过程开始时设置设计规则。在线 DRC 功能将在您工

作时监控启用的规则，并立即突出显示检测到的任何设计违规。或者，您也可以运行批量 DRC，以

测试设计是否符合规则，生成报告以详细说明启用的规则以及检测到的违规行为。 

 

在本教程的前面，您检查了走线设计规则，添加了一个新的宽度约束规则，该规则以电源网为目标，

以及电气间隙约束和通过样式规则的走线。除了这些，还有一些其他设计规则在创建新的电路板时

自动定义。 

配置显示规则违规 

主要文章：PCB 编辑器 - DRC 违规显示 

 

在检查规则违规之前，了解如何显示违规很重要。 

 

Altium Designer 有两种显示设计规则违规的技术，每种都有其自身的优势。这些配置在 PCB 编辑

器 - Preferences（选项）对话框的 DRC 违规显示页面中： 

•违规覆盖 - 违规通过以 DRC 错误标记（在“查看配置”面板中配置，按 L键打开）中选择的颜

色突出显示的错误原始图标来标识。默认行为是在缩小时以纯色显示图元，并在放大时更改为选

定的“违例叠加样式”。默认值为样式 B，其中带有十字的圆形。 

•违规详细信息 - 当您进一步放大违规详细信息时（如果启用），详细说明错误的性质。违规详

情可能包括：◦违规网站的信息， 

在适当情况下，用于指示违规类型的图标，例如细线可以跨越，指示短路， 



显示失败的规则设置的数值，例如<0.25mm。

 

违规行为可以显示为彩色覆盖图，也可以显示为详细消息，不同的符号用于显示错误类型的不同细

节。 

  



 

 

当您放大对选定的违规覆盖样式（中心图像）的这些更改时，违例会以纯绿色（左图）显示，因为

您将进一步放大违规详细信息。 

 

准备运行设计规则检查（DRC） 

1.选择 » View Configuration（快捷方式：L）并确认已启用 DRC 错误可见性选项（系统颜

色部分），以显示 DRC 错误标记。 

2.确认 Online DRC（设计规则检查）系统已启用，该复选框位于 Preferences 对话框的 PCB Editor 

- General 页面中。保持“Preferences（选项）”对话框处于打开状态，然后切换到对话框的 PCB

编辑器 - DRC 违规显示页面。 

3. PCB 编辑器 - Preferences（选项）对话框的 DRC 违规显示页面用于配置工作区中如何显示违

规。有两种不同的显示违规的方法，每种都有自己的优势。 

4.对于本教程，右键单击 PCB 编辑器的显示区域 - Preferences（选项）对话框的 DRC Violations 

Display页面，然后选择Show Violation Details - Used，然后再次右键单击并选择Show Violation 

Overlay - Used，如图所示上面的对话框图像。 

5.你现在准备好检查设计是否有错误。 

 

所需的规则将取决于设计的性质，没有适合每种设计的特定规则。请记住，当您检查规则违规时，

问问自己，我是否需要启用此规则？如果您试图在 PCB 规则和约束条件编辑器中计算规则的功能并

且不确定，请单击规则的约束区域中的任意位置，然后按 F1 以获取有关该特定规则的更多信息。 

 

配置规则检查器 

对话框页面：设计规则检查器 

 

通过运行设计规则检查器来检查设计是否存在违规。运行 Tools » Design Rule Check 命令打开

对话框。在线和批量 DRC 都在此对话框中配置。 



 

DRC 报告选项 

•默认情况下，对话框打开，显示对话框左侧树中选择的报告选项页面（如下所示）。 

•对话框的右侧显示常规报告选项的列表，有关选项的更多信息，请在光标位于对话框上时按 F1

键。这些选项可以保留默认值。 

 

 

 

规则检查（联机和批处理）在“设计规则检查器”对话框中进行配置。 

 



DRC 规则检查 

•在对话框的规则检查部分中配置特定规则的测试，在对话框左侧的树中选择此页面以列出所有规

则类型（如下所示）。 您还可以通过选择对话框左侧的页面来按类型检查它们，例如 Electrical。 

•对于大多数规则类型，在线（在工作时检查）和批处理（当单击“运行设计规则检查”按钮时检

查此规则）复选框。 

•点击以根据需要启用/禁用规则。 或者，右键单击以显示上下文菜单。 通过此菜单，您可以快速

切换在线和批处理设置，选择 Batch DRC - Used On 进入设置，如下图所示。 

 

检查是为每个规则类型配置的，使用右键单击菜单启用使用的设计规则。 

 

运行设计规则检查（DRC） 

单击对话框底部的运行设计规则检查按钮以执行设计规则检查。当按钮被点击时，DRC 将运行，然

后： 

•Messages 面板将出现，列出所有检测到的错误。 



•如果在对话框的“报告选项”页面中启用了“创建报告文件”选项，则设计规则验证报告将在单

独的文档选项卡中打开，本教程报告如下所示。  

◦报告上部详细列出了启用检查的规则以及检测到的违规数量，单击规则跳转报告并检查这些错误。 

◦违反规则的摘要下面是每个违规行为的具体细节。 

◦报告中的链接是实时的，单击某个特定错误可跳回到电路板并检查电路板上的错误。请注意，此

点击操作的缩放级别在“Preferences（选项）”对话框的“System - Navigation(导航)”页面

中进行配置，试验以找到适合您的缩放级别。 



 



报告的上半部分详细列出了为检查而启用的规则以及检测到的违规数量，单击规则跳转报告并检查

这些错误。 



 



报告的下半部分显示了每个违反的规则，后面跟着一个错误的对象列表。点击一个错误跳转到 PCB

上的那个对象。 

 

查找错误状况 

当你对这个软件不熟悉的时候，一长串的违规行为最初看起来可能非常令人难以置信。管理这种方

法的一个好方法是在设计过程的不同阶段在设计规则检查对话框中禁用和启用规则。如果存在违规

行为，仅检查它们，则不建议自行停用设计规则。例如，您将始终禁用 Un-Routed Net 检查，直到

电路板完全布线。 

•在教程板上运行批次 DRC 时，会出现： 

◦2Silk to Silk 间隙错误 - 两个相邻丝网之间的距离小于此规则允许的距离。 

◦8Silk to Solder Mask 间隙错误 - 从阻焊层开口到丝网物体丝印边缘的距离小于此规则允许的

距离。 

◦4 最小 Solder Mask Sliver 误差 - 一条阻焊条的最小宽度小于此规则允许的最小宽度。这通常

发生在组件焊盘之间。 

◦4 间隙约束违规 - 信号层上物体之间测得的电气间隙值小于本规则规定的最小值。 

 

•查找一个违例： 

◦单击报告文件中的链接或 

◦在消息面板中双击， 

◦在 PCB 规则和违规面板上点击违规。 

  

•使用违规详细信息，您可以确定错误情况。 

•下图显示了间隙约束误差之一的违规详情，用白色箭头和 0.25mm 文字表示，表明该间隙小于规则

允许的最小 0.25mm。下一步是确定实际价值是什么，以便知道其失败的程度，然后决定如何解决

此错误。 

 

违规详情显示这两个垫之间的间隙小于 0.25mm，但并未详细说明实际间隙。 

 



了解错误状况 

所以你发现了一个错误，你怎么知道它失败了多少？作为设计师，您需要这些重要信息，以便能够

决定如何最好地解决错误。 

 

例如，如果规则规定允许的最小阻焊条宽为 0.25mm，而实际为 0.24mm，则情况并非如此糟糕，您

可能会调整规则设置以接受此值。但是，如果实际为 0.02mm，那么可能不是可以通过调整规则设

置来解决的情况。 

 

 

PC 编辑器包括三个方便的测量工具，测量距离，测量所选对象和测量基元，可在报告菜单中找到。 

•测量距离 - 测量运行该命令后单击的两个位置之间的距离，并留意状态栏上的说明。您可以单

击的位置受当前捕捉网格的约束。 

•测量所选对象 - 测量所选轨迹和弧的长度。使用它来计算路径长度，手动选择所需的对象，或

使用选择»物理连接或选择»连接铜缆命令。 

•测量基元 - 测量运行该命令后单击的 2个基元之间的边缘距离，并留意状态栏上的说明。 

•测量结果直接叠加在工作区中，所使用的颜色在“视图配置”面板的“系统颜色”部分中配置。

在屏幕上保留重叠尺寸以允许执行多个测量，按 Shift + C 清除测量结果。 

 

使用 Measure Primitives 命令测量相邻焊盘边缘之间的距离。 

 

除了实际测量距离外，还有很多方法可以找出规则失败的原因。 您可以使用： 

•右键单击Violations（违规）子菜单或 

•PCB 规则和违规面板，或 

•“消息”面板中包含的详细信息 - 实际值与指定值一起详细说明（例如，0.175 <0.254）。 

 

违规子菜单 

在“现有设计规则违规”部分的前面介绍了右键单击“Violations（违规）”子菜单。 



•下图显示 Violations（违规）子菜单如何将测量条件与规则指定的值相比较。 

 
右键点击违规行为，查看违规情况和违规情况。 

 

PCB 规则和违规面板 

主要文章：PCB 规则和违规面板 

 

PCB 规则和违规面板是用于查找和理解错误条件的优秀功能。 

•单击按钮并从菜单中选择 PCB 规则和违规以显示面板。 它将默认显示规则类列表中的[所有规则]。 

一旦确定了感兴趣的规则类型，请选择该特定的规则类，以便仅在面板底部显示这些违规。 

•单击列表中的违规行为跳至板上的违规行为，双击违规行为以打开“违规详细信息”对话框。 

 

该面板详细说明违规类型，测量值，规则设置和违规对象。 

 

请注意，在 PCB 规则和违规面板的顶部有一个下拉菜单，可用于选择 Normal, Dim（暗淡） or Mask

（蒙版）。 



 Dim 和 Mask 是显示过滤器模式，除了感兴趣的对象之外的所有东西都会淡化，仅保留所选对象的

正常显示强度。 Dim 模式应用过滤器，但仍然允许编辑所有工作区对象，Mask 模式过滤掉所有其

他工作区对象，只允许编辑未过滤的对象。 

 

显示器变暗的量由“视图配置”面板的“视图选项”选项卡的“蒙版和暗淡设置”部分中的“变暗

对象”和“蒙版对象”滑块控件控制。 在应用遮罩模式或暗淡模式时尝试使用这些滑块。 

 

要清除过滤器，您可以单击“查看配置”面板顶部的清除按钮，或者按 Shift + C 快捷方式。此

过滤功能在繁忙的工作区中非常有效，也可用于 PCB 面板和 PCB 过滤面板。 

 

解决违规问题 

作为设计师，您必须制定解决每个违反设计规则的最合适方法。让我们从阻焊错误开始，因为它们

是相关的，并且这两种错误情况可能会受到对阻焊设置所做更改的影响。 

 

阻焊错误 

设计规则参考：Minimum Solder Mask Sliver, Silk to Solder Mask Clearance 

 

阻焊层是一种涂在电路板外表面的薄薄的漆层，为铜提供了一层保护和绝缘层。打开是在阻焊膜中

为要焊接到铜上的元件和电线而创建的，这些开口在 PCB 编辑器中的阻焊层上显示为对象（请注意，

阻焊层定义在负面 - 物体你会发现在实际的阻焊层中出现了漏洞）。 

 

在制造过程中，使用不同的技术施加阻焊膜，成本最低的方法是通过掩膜丝网印刷到板表面上。为

了考虑层对准问题，阻焊膜开口通常比焊盘大，反映在默认设计规则中使用的 4mil（约 0.1mm）扩

展值。 

 

还有其他技术可用于应用阻焊层，这种技术可提供更高质量的层配准和更精确的形状定义，如果使

用这些技术，则阻焊层扩展可能更小甚至为零。减少掩模开口可以减少阻焊条或丝印到阻焊膜间



隙误差的机会。

 

左侧显示阻焊膜条错误，右侧显示阻焊膜错误错误，紫色表示每个焊盘周围的阻焊膜扩展。 

 

如果不考虑用于制造成品板的制造技术，则无法解决诸如这些阻焊层问题的错误。 

 

例如，如果这是用于高价值产品的复杂多层板，那么很可能会采用高质量的阻焊膜技术，这将允许

小的或零阻焊膜扩展。 然而，像教程这样简单的双面电路板更有可能被制造成低成本产品，需要

使用低成本的阻焊技术。 这意味着通过减少整个电路板的阻焊膜扩展来解决阻焊膜错误不是一个

合适的解决方案。 

 

像 PCB 设计的许多方面一样，解决方案就是以集中的方式进行深思熟虑的权衡，以最大限度地降低

其影响。 



 

解决阻焊膜违规 

要解决此违规问题，您可以： 

1.增加阻焊层开口，以完全去除晶体管焊盘之间的掩膜，或者 

2.降低最小可接受的条子宽度，或 

3.减少面罩开口，将条子展宽至可接受的宽度。 

 

这是根据您对部件的知识以及将要使用的制造和装配技术而作出的设计决定。打开阻焊膜以完全去

除晶体管焊盘之间的阻焊膜意味着在这些焊盘之间产生焊桥的可能性更大，而减小阻焊膜开口仍然

会留下条子，这可能或可能不可接受，并且还会引入阻焊膜到焊盘配准问题的可能性。 

 

在本教程中，您将执行第二个和第三个选项的组合，将最小阻焊条宽度减小到适合于该板上使用

的设置的值，并且还可以减小阻焊膜扩展，但仅限于晶体管焊盘。 

1.第一步是降低允许的条子宽度。为此，请打开 PCB 规则和约束条件编辑器，然后在制造部分中找

到并选择现有的最小阻焊条规则，称为 MinimumSolderMaskSliver。 

2.对于这样的设计，等于 0.22mm（≈8.7mil）的焊盘间距的值是可以接受的，在规则的约束区域

中将最小阻焊膜的值编辑为 0.22mm。 

 

 

 



3.现在单击对话框左侧树中的 Mask 来显示当前的 Solder Mask Expansion 规则，应该有一条规则，

称为 SolderMaskExpansion。 

4.点击它来选择规则并显示其设置，它将指定扩展值为 0.102mm（4mil）。只有晶体管焊盘违规，

而您不用编辑此值也将创建新的规则。 

5.要添加新的阻焊扩展规则，请右键单击规则并从菜单中选择新规则。 一个名为

SolderMaskExpansion_1 的新规则将被创建，点击它来显示其设置。 

6.编辑规则设置如下所示： 

•名称 - SolderMaskExpansion_Transistor 阻焊层扩张晶体管 

•对象匹配的位置 - 占位面积 ONSC-TO-92-3-29-11（晶体管占位面积的名称） 

•扩展顶部/底部 - 0 毫米 

 

7.单击应用接受更改并保持打开 PCB 规则和约束条件编辑器。 

 

解决 Silk to Solder Mask 清除违规问题 

此规则的功能是确保丝网印刷物和铜之间有足够的分离。 该规则支持检查掩模中的开口，或检查

掩模中的开口暴露的铜。 

1.对于这种违规行为，实际测量值接近目前的规则设置，0.175mm 与 0.25mm 之间，可以在消息或

PCB 规则和违规面板中看到。 值 0.175mm 仍然是一个可接受的分隔符，请编辑约束值，如下图所

示。 



 

编辑间隙为 0.175mm。 

2.单击确定接受更改并关闭 PCB 规则和约束条件编辑器。 

 

清除违规行为 

设计规则参考：清除约束 

 

有两种方法可以解决这种间隙限制： 

•减小晶体管封装焊盘的尺寸以增加焊盘之间的间隙，或者 

•配置规则，使晶体管封装焊盘之间的间隙更小。 

 

由于 0.25 毫米的间隙非常大，实际的间隙非常接近这个值（0.22 毫米），所以在这种情况下，一

个好的选择是配置规则以允许更小的间隙。这可以在现有的 Clearance Constraint 设计规则中完

成，如下所示。 

•规则约束的网格区域中的 TH Pad 到 TH Pad 值更改为 0.22mm。要编辑一个单元格，请先选择它，

然后按 F2。 

•这种解决方案在这种情况下是可以接受的，因为唯一带有通孔焊盘的其他组件是连接器，其间的

焊盘间距超过 1mm。如果情况并非如此，那么最好的解决方案是增加一个针对晶体管焊盘的第二间

隙约束，就像阻焊扩展规则所做的那样。 



 

编辑间隙约束以允许 TH 垫到 TH 垫的间隙为 0.22mm。 

 

丝印到丝印间隙违规 

设计规则参考：丝印到丝印间隙 

 

要解决的最后一个错误是丝印违规问题。 这些通常是由指示符太靠近相邻组件的轮廓引起的。 您

的设计可能没有任何这些违规 - 这取决于您放置组件的距离有多近，或者您已经重新定位了指示

器。 点击并按住指示器将其移动 - 所有对象将与指示器正在移动的组件中的对象变暗 - 将该指

示器移动到新位置。 

 

指定符的移动将受到当前捕捉网格的约束，如果当前过于粗糙，请按 Ctrl + G 并输入新的网格值。 



 

重新定位导致丝绸违规的任何指示符。 

 

 

在生成输出之前，始终确认您有干净的设计规则验证报告。 

 

做得好！您已完成 PCB 布局并准备好生成输出文档。在此之前，让我们来看看 PCB 编辑器的 3D 功

能。 

 

以 3D 观看您的主板 

PCB 编辑器需要支持 DirectX 9.0c 和 Shader Model 3（或更好）的图形卡。 

 

Altium Designer 的一个强大功能是可以将您的开发板视为三维物体。要切换到 3D，请运行查看»3D

布局模式命令，或按 3快捷键。该板将显示为三维对象 - 教程板如下所示。 

 

您可以使用以下控件流畅地缩放视图，旋转视图，甚至在板内移动： 

•缩放 - Ctrl +右键拖动鼠标或 Ctrl +滚动鼠标滚轮或 PgUp / PgDn 键。 

•平移 - 右键拖动鼠标或标准的 Windows 鼠标滚轮控件。 

•旋转 - Shift +右键拖动鼠标。请注意，按 Shift 时如何在当前光标位置出现方向球体，如下图

所示。使用以下控件，模型的旋转运动是围绕球体的中心（在按 Shift 键定位球体之前定位光标的

位置）。移动鼠标以突出显示所需的控件，然后： 



◦中心点突出显示时，右键拖动球体 - 向任意方向旋转。 

◦水平箭头突出显示时，右键拖动球体 - 旋转关于 Y轴的视图。 

◦垂直箭头突出显示时，右键拖动球体 - 旋转关于 X轴的视图。 

◦圆形段突出显示时，右键拖动球体 - 旋转关于 Z形平面的视图。 

 

按住 Shift 键显示 3D 视图方向球体，然后单击并拖动鼠标右键旋转。 

 

在 3D 中工作的技巧 

•当板处于 3D 布局模式时，按 L 可打开“查看配置”面板，您可在其中配置 3D 工作站显示选项（“查

看选项”选项卡，常规设置和 3D 设置部分）。 

•3D 显示颜色可以使用“真实”或“按层”，它们是 2D 布局模式中定义的图层颜色。定义了许多

3D 配置，请在“视图配置”面板的“常规设置”中查看这些配置。 

•有控件可配置层颜色以及电路板厚度（垂直缩放比例），这对于检查 PCB 中的内部层和互连结构

非常方便。 3D 图层具有透明度设置，将其滑动到“透视”该图层上的对象。 

•您可以选择显示 3D 物体，或隐藏它们。 

•要以 3D 形式显示组件，每个组件都需要在其占用空间中包含合适的 3D 模型。请参阅组件对象页

面和 3D Body 对象页面，了解有关包含 3D 模型的更多信息，并查看 ECAD-MCAD 集成文章中的 3D

优势，以了解如何在其占用空间中放置模型。 

•除组件制造商的网站外，3D 模型还可用于： 

◦社区门户网站，例如 3D Content Central 和 GrabCAD，其中设计人员共享模型。 



◦越来越多的商业 3D 网站，包括 Accelerated Designs 和 PCB 3D。 

 

•如果没有合适的 STEP 模型可用，请在库编辑器中将多个三维实体对象放置在脚印中，以创建您自

己的组件形状。 

 

如果您打算定期使用 3D 模式，那么您可能需要检查 3D 鼠标，例如 3Dconnexion 中的 Space 

Navigator，这大大简化了在 3D 布局模式下移动和旋转电路板的过程。 

 

 

 

三、输出文档 

主要文章：更多关于产出 

 

现在您已经完成了 PCB 的设计和布局，您已准备好制作需要审核，制造和组装的电路板输出文件。 

 

最终目标是制造和组装电路板。 



 

输出类型包括 PDF 3D，具有全缩放，平移和旋转功能，并且可以在 Adobe AcrobatReader®中控制

网络，组件和丝网的显示。 

 

可用的输出类型 

由于 PCB 制造中存在多种技术和方法，该软件可以为不同目的生产多种输出类型： 

 

装配输出 

•组装图纸 - 组件的位置和方向为板的每一面。 

•拾取和放置文件 - 由机器人组件放置机器用于将组件放置在电路板上。请注意，Report Output

也可用于生成 Pick and Place 文件，并且具有高度可配置性。 

 

文档输出 

•PCB 打印 - 配置任何数量或打印输出（页面），以及图元的任何排列和基元显示，使用它来创建

印刷输出，如装配图。 

•PCB 3D 打印 - 从三维视角来看板的视图。 



•PCB 3D 视频 - 根据 PCB 编辑器的 PCB 3D Movie Editor 面板中定义的一系列 3D 关键帧输出板的

简单视频。 

•PDF 3D - 生成电路板的 3D PDF 视图，完全支持在 AdobeAcrobat®中进行缩放，平移和旋转。 PDF

包含一个模型树，控制网络，组件和丝网的显示。 

•原理图打印 - 设计中使用的示意图。 

 

制作输出 

•复合钻头图纸 - 在一张图纸中钻孔板的位置和尺寸（使用符号）。 

•钻取图纸/导轨 - 在单独的图纸中钻取纸板的位置和尺寸（使用符号）。 

•最终作品打印 - 将各种制作输出合并为一个可打印输出。 

•Gerber 文件 - 以 Gerber 格式创建制造信息。 

•Gerber X2 文件 - 封装高级设计信息的新标准，向后兼容原始 Gerber 格式。 

•IPC-2581 文件 - 一种将高级设计信息封装在单个文件中的新标准。 

•NC 钻孔文件 - 创建供数控钻孔机使用的制造信息。 

•ODB ++ - 以 ODB ++数据库格式创建制造信息。 

•Power-Plane 打印 - 创建内部和分割平面图纸。 

•焊接/粘贴蒙版打印 - 创建阻焊层和粘贴蒙版图纸。 

•测试点报告 - 以各种格式为设计创建测试点输出。 

 

网表输出 

•网表列出了设计中各组件之间的逻辑连接，对于传输至其他电子设计应用非常有用。支持各种各

样的网表格式。 

 

报告输出 

•物料清单 - 创建制造电路板所需的各种格式的零件和数量（BOM）清单。 

•组件交叉参考报告 - 根据设计中的示意图创建组件列表。 

•报告项目层次结构 - 创建项目中使用的源文件列表。 

•报告单引脚网络 - 创建一个报告，列出只有一个连接的任何网络。 

•简单 BOM - 创建 BOM 的文本和 CSV（逗号分隔变量）文件。 

•电气规则检查 - 格式化运行电气规则检查结果报告。 

 

单独的输出或输出作业文件（输出 Gerber 文件） 

主要文章：在 OutputJob 中准备多个输出 



 

Altium Designer 有两个独立的配置和生成输出的机制： 

1.独立 - 每种输出类型的设置都存储在 Project 文件中。您可以根据需要通过 Fabrication 

Outputs，Assembly Outputs 和 Export 子菜单（可从 File 菜单访问）和 Reports 菜单中的命令选

择性地生成该输出。 

2.选择输出作业文件 - 每种输出类型的设置都存储在输出作业文件中，该文件是专用的输出设置

文档，支持所有可能的输出类型。这些输出可以手动生成，或作为托管版本生成。 

 

输出作业文件允许您配置每种输出类型，配置输出命名，格式和输出位置。输出作业文件也可以

从一个项目复制到另一个项目。 

 

虽然单个输出的设置对话框与输出作业中使用的对话框相同，但这些设置是独立的，并且如果从一

种方法切换到另一种方法，则必须重新进行设置。 

 

将输出作业添加到项目 

OutputJob 文件或 OutJob 将每个输出设置（在左侧的列表中）映射到输出容器（在右侧的列中）。

输出设置定义了你想要输出的内容（双击来配置），容器定义了输出写入的位置（双击图标或者单

击更改链接）。可以在 OutJob 中添加任意数量的输出，并且可以将输出映射到单个或共享的输出

容器。 

1.在“项目”面板中，右键单击项目名称，然后选择 Add New to Project » Output Job File。

新的 OutJob 将被打开并添加到项目中。 



保存 OutJob 并命名为 Multivibrator（多谐振荡器）。它会自动保存在与项目文件相同的文件夹

中。 

3.要添加新的 Gerber 输出，请单击  链接 OutJob 的 Fabrication Outputs

部分，然后选择 Gerber»[PCB 文档]，如下图所示。如果选择[PCB 文档]选项，则自动选择项目 PCB。

选择这也意味着OutJob可以在项目之间轻松复制，因为此设置不需要更新。如果项目中有多个PCB，

则需要选择特定的电路板。 

4. Gerber 输出已添加，您将尽快进行配置。 

 

配置 Gerber 文件 

对话页面：Gerber 设置 

 

•Gerber 仍然是电路板设计和电路板制造之间最常见的数据传输形式，ODB ++越来越受欢迎。 

•每个 Gerber 文件对应物理板的一层 - 组件叠加层，顶层信号层，底层信号层，顶层阻焊层等。 在

提供制作设计所需的输出文件之前，建议咨询您的电路板制造商以确认其要求。 

•如果电路板上有任何孔，则还必须使用相同的单位、分辨率和 film(菲林、胶片)设置的位置生成

NC 钻孔文件。 

•在 Gerber 设置对话框中配置 Gerber 文件，通过 PCB 编辑器的文件»Fabrication Outputs»Gerber

文件访问，或者通过在输出作业的 Fabrication Outputs 部分添加 Gerber 输出，然后双击它。 



 

 

在 Gerber 设置对话框中配置 Gerber 输出。 

 

配置 Gerber 生成 

1.在 OutJob 中，双击 Gerber Files 输出，Gerber Setup 对话框将打开，如上图所示。 

2.由于电路板在公制中设计，因此将单位设置为毫米。在对话框的常规选项卡中。 

3.电路板上使用的最小单元的走线和间隙为 0.25 毫米，但由于大多数元件的参考点位于其几何中

心（并放置在 1 毫米的网格上），因此其中一些电极板实际上会打开 0.01 格。在常规选项卡上将

格式设置为 4：3，这可以确保输出数据的分辨率足以覆盖这些网格位置。注意：NC 钻取文件必须

始终配置为使用相同的单位和格式。 

4.切换到图层选项卡，然后单击绘图层按钮并选择使用。请注意，可能会启用机械层，这些层通常

不是自己编写的。相反，如果他们持有其他图层上需要的详细信息，则通常会包含它们，例如每个

Gerber 文件都需要的对齐位置标记。在这种情况下，对话框右侧的“机械层”选项用于在另一层

包含该细节。禁用在对话框的“图层对图”部分中启用的任何机械图层。 

5.点击对话框的高级选项卡。确认胶片位置选项设置为参照相对原点。注意：必须始终将 NC 钻孔

文件配置为使用相同的格式：film(胶片)设置上的单位，格式和位置作为 Gerber 文件，否则钻孔

位置将与焊盘位置不匹配！ 

6.单击确定接受其他默认设置并关闭 Gerber 设置对话框。 

7.现在Gerber设置已配置好，下一步是配置它们的命名和输出位置。这是通过将它们映射到OutJob

右侧的 Output Container 来完成的。对于具有各自文件格式的离散文件，您使用文件夹结构容器，

在输出容器列表中选择文件夹结构，然后单击输出的已启用列中的 Gerber 文件单选按钮，将此输

出映射到所选容器， 如下所示。 

 



 

OutJob 配置为将 Gerber，NC Drill 和 Pick and Place 输出生成为离散文件。 

 

8.最后一步是配置容器，单击容器中的更改链接以打开文件夹结构设置对话框。在顶部是一组控件，

用于配置输出是“发布管理”还是“手动管理”，并将它们设置为“手动管理”。查看其他选项，

对话框的下半部分将显示名称和文件夹结构在您选择不同选项时的变化。 

9.单击文件夹结构设置对话框底部的高级按钮，并在 CAMtastic 自动加载选项列表中启用 Gerber

输出。点击确定关闭对话框。 

10.要生成 Gerber 文件，请单击 OutJob 的容器区域中的生成内容链接。 

11.这些文件将在集成的 CAM 编辑器中生成并打开，可用于 CAM 文件的最终检查，然后再发布到制

造。关闭 CAM 文件而不保存它。 

 

配置物料清单 

主要文章：ActiveBOM 的 BOM 管理 

 

最终，设计中使用的每个零件都必须有详细的供应链信息。而不是要求将这些信息添加到每个设计

组件中，或者将其作为 Excel 电子表格中的后处理进行添加，您可以在 ActiveBOM 中的任何时间通

过设计周期添加它。 

 

ActiveBOM 是 Altium Designer 中包含的组件管理编辑器，用于： 

•配置组件信息以使其可以准备好 BOM，包括添加其他非 PCB 组件 BOM 项目，例如裸板，胶水，安

装硬件等。 

•添加更多列（如行号列）以适应装配工厂的要求。 

•将每个设计组件映射到真实世界的制造商零件。 

•确定每个零件的供应链可用性和价格，以确定一定数量的制造单位。 

•计算生产单位的定义数量的生产成本。 

 



 

ActiveBOM 用于将每个设计组件映射到实物元件。 

 

这种将供应链详细信息直接注入物料清单的能力改变了 BOM 文件在 PCB 项目中的作用。 ActiveBOM

不再是一个简单的输出文件，它提出了组件管理过程，以便与原理图捕获和 PCB 设计过程并行，

ActiveBOM 的 BomDoc 成为 PCB 项目的所有物料清单数据源，适用于所有 BOM 类型的输出。 对于来

自 Altium Designer 18 的所有版本，ActiveBOM 是推荐的 BOM 管理方法。 

 

ActiveBOM 实时查询供应链，这意味着本教程中使用的零件的可用性将随时间而改变。 可用供应

商的名单也随时间而改变。 

 

由于这些原因，您获得的结果可能与本教程中显示和描述的结果不同。 

 

配置 BomDoc 

在教程中包含一个 BomDoc： 

1.从菜单中选择文件»新建»ActiveBOM 文档。请注意，PCB 项目只能包含一个 BomDoc。 

2.将创建 BomDoc，并将本教程中使用的组件列为 BOM 项目。 BomDoc 在“属性”面板中进行配置，

其中定义了产品数量和货币，供应链和可见 BOM 项目参数以及其他设置。花点时间熟悉面板两个选

项卡中的可用功能。请注意，该面板在顶部包含一个搜索字段，方便快速查找控件或参数。 

3.在面板的“列”选项卡中，找到并禁用以下参数的可见性： 

制造商生命周期 1，供应商小计 1。 



4.组件在 BomDoc 的主要区域进行了详细说明。默认情况下会有一个标题为 Line＃的列，单击 Set 

Line Numbers 按钮（ ）填充此列。  

5.因为组件是从 Altium Content Vault 放置的，所以每个部件都包含了供应链信息。当您单击 BOM

物料表格中的零件时，其供应链信息显示在 BomDoc 的较低区域，如上图所示。在 BomDoc 的这个较

低区域中显示的每一行被称为解决方案，其左侧显示制造商零件编号（称为 MPN），并显示可用的

供应商+供应商零件编号（称为 SPN）在右侧的每个瓦片中。 

6.注意“BOM 物料”网格包括右侧的“状态”列，将鼠标光标悬停在状态图标上可获取有关检测到

的任何问题的信息。 

7.状态图标应表明所有项目都包含没有 MPN 排列的错误。这意味着设计师（您）尚未检查选定的零

件（MPN），并表示他们对每个零件都感到满意。通过为其分配一个等级来接受 MPN（如上图所示）。

对于每个项目，除了晶体管以外都要这样做。 

8.在“属性”面板中，根据 BOM Checks 的当前配置检查每个项目的状态。面板中的“BOM 检查”

列表详细列出了当前正在违反的所有 BOM 检查。在 Bom Checks 对话框中配置可用的 BOM 检查及其

当前设置，单击 BOM 检查列表下面的图标 打开对话框。 

9.在“BOM 检查”列表的“与设计项目相关的违规”部分中，有一项称为“组件修订”的检查已过

期。要观察修改 BOM 检查的影响，将其设置为 No Report，然后单击 OK 关闭对话框。 

10.五个物料清单物料中的四个物料的状态应变为绿色（ ），表示这些物料已清除（准备订购）。 

11.选择晶体管项目，它可能会被标记为过时并且没有 SPN。对于没有分配 MPN 或 MPN 但没有供应

商的物料，您可以添加手动解决方案。 

12.为此，请单击添加解决方案按钮，然后从出现的菜单中选择添加手动解决方案。 

13. Add New Part Choice 对话框将打开。此对话框用于查找携带合适零件的供应商，并检查价格

和可用性。请注意，允许的供应商列表在“Preferences（选项）”对话框的“数据管理 - 零件

供应商”页面中配置。 

14.在 Add New Part Choice 对话框中，找到供应商部分 Fairchild Semiconductor BC547CTA。在

包含此部分的供应商列表中，找到包含单价中的条目的 Digi-Key 部分。 

15.要在解决方案中使用此部分，单击位于对话框中间的细长的>>按钮 - 当您执行组件的详细信息

时，将填充对话框右侧的字段。点击确定关闭对话框。 

飞兆半导体晶体管现在将被列为 BomDoc 中提出的解决方案，如下所示。 

17.所有零件现在包含供应链详细信息，保存 BomDoc 和项目。您现在已准备好生成 BOM。 

 

 



生成 BOM 

对话框页面：报告管理器 

 

生成的实际输出 BOM 文件通过报表管理器生成。报告管理器是一个高度可配置的报告生成引擎，可

以生成各种格式的输出，包括：文本，CSV，PDF，HTML 和 Excel。 Excel 格式的 BOM 也可以使用

预先定义的模板之一或您自己的模板应用模板。 

•物料清单输出由“项目物料清单”对话框生成，可通过以下方式访问： 

1.PCB 编辑器的“报告”»物料清单或 

2.通过在输出作业的报告输出部分中添加物料清单，或 

3.通过将 BomDoc 添加到项目中，并运行 BomDoc 的报告»材料清单命令。 

 

•如果项目包含 BomDoc，则默认行为是让 Report Manager 以与在 BomDoc 中配置相同的方式显示组

件详细信息。 

•在对话框的左侧，列出了设计中所有组件的每个组件属性。启用您希望包含在 BOM 中的每个属性

的复选框，清除您希望删除的属性的复选框。 

•如果项目不包含 BomDoc，报告管理器将包含一个额外的区域，用于定义如何识别用于群集的组件。

通过将组件属性添加到对话框的“分组列”区域来实现集群。如果您希望每个组件都位于 BOM 中其

自己的行上，请单击并将这些属性拖出分组列，然后将它们放回到“所有列”区域中。 

•对话框的主要网格区域是写入 BOM 中的内容。在这个区域你可以：点击并拖动重新排列列;点击列

标题按该列进行排序; ctrl +点击按该列进行分类排序;使用每个列标题中的小下拉列表为列定义

基于值的过滤器;右键单击以强制列以适合当前对话框宽度。 

•BOM 生成器从原理图中获取其信息，启用“包含来自 PCB 的参数”选项以访问 PCB 信息，如需要

的话可以访问 PCB 的位置和侧面。 

 



报表管理器，用于包含 BomDoc 的项目。如果项目中没有包含 BomDoc，则对话框的显示会发生变化。 

 

将设计数据映射到 BOM 中 

主要文章：在 Excel BOM 中包含设计数据 

 

通过在用于创建 BOM 的 Excel 模板中包含特殊语句，可以将设计数据从 Altium Designer 传递到

Excel 物料清单。 

 

在 Excel 中创建物料清单模板时，可以使用字段和列的组合来指定所需的布局。 Altium Designer

提供了几个示例模板，位于安装用户文件的\Templates 文件夹中。下面详细列出了可用字段： 

 

将设计数据映射到 BOM 中 

Fields 

Fields 提供项目级信息。这些通常不附加到 BOM 中列出的每个项目，但通常用在文档的标题中。 

Fields 的格式如下所示： Field=FieldName 

一个例子是 Field = Currency 

可用 Fields 包括： 

Currency              DataSourceFileName     DataSourceFullPath  

GeneratorDescription    GeneratorName         OutputName  

OutputType            ProductionQuantity      ProjectFileName  

ProjectFullPath         ReportDate             ReportDateTime  

ReportTime            TotalQuantity           Title (title of BOM)  

VariantName  

 

文档和项目参数 

除上表中列出的默认 Fields 外，原理图文档参数（原理图文档选项对话框中的默认和用户自定义）

和项目参数（用于 PCB 项目对话框的选项）也可用作 Fields。 

 

这些被输入为： 

Field=ParameterName 

 

如果同一个参数既作为文档参数又作为项目参数存在，则项目参数优先。 如果多个文档中存在相

同的文档参数，则层次结构中位于上方的文档参数优先。 

 



以下是默认的文档参数，也称为系统参数。 

Address1      Address2       Address3  

Address4      ApprovedBy      Author  

CheckedBy      CompanyName      ConfigurationParameters  

CurrentDate      CurrentTime       Date  

DocumentFullPathAndName  DocumentName      DocumentNumber  

DrawnBy      Engineer       ImagePath  

Index       ModifiedDate      Organization  

Revision       Rule        SheetNumber  

SheetTotal      Time 

 

Columns 

Columns 提供以组件为单位提供的信息，并通常显示在 BOM 中的每一行上。通过输入列标题来定义

列，格式为： 

 

Column=ColumnName 

 

一个例子是 Column = Description 或 Column = LibRef 

 

Columns 信息可以从多个来源获取，包括： 

•默认组件参数（例如指示符或说明）， 

•用户定义的参数添加到组件， 

•PCB 数据， 

•供应商数据。 

 

这些在下面分别讨论。 

 

 

默认参数 

这些 ColumnName 可用于所有组件： 

 

Comment      ComponentKind   Description  

Designator   DesignItemId   Footprint  

LibRef    LogicalDesignator  PartType  

PhysicalPath     Quantity    UniqueIdName  

UniqueIdPath 

   



PCB 参数 

 

拾取和放置信息也可以包含在 PCB 中。为了使用这些列，必须在“BOM 配置”对话框中勾选“包括

PCB 参数”复选框。 

Center-X（Mil） Center-X（mm） Center-Y（Mil） 

Center-Y（mm） Layer    Pad-X（Mil） 

Pad-X（mm）  Pad-Y（Mil） Pad-Y（mm） 

Ref-X（Mil） Ref-X（mm）  Ref-Y（Mil） 

Ref-Y（mm）  Rotation 

 

供应商数据 

可以从供应商处检索在线数据，并将其提供到 BOM 中。请注意，这些更新会实时更新，并在生成

BOM 时检索。可以为每个组件设置多个供应商。在下表中，这些被描述为供应商信息 x - 用适当的

数字替换 x。 

 

制造商 x   制造商部件号 x  供应商 x 

供应商货币 x  供应商订单数量 x  供应商零件编号 x 

供应商库存 x  供应商小计 x   供应商单价 x 

 

如果您刚刚在原理图中编辑了参数并希望在 BOM 中看到它们，请保存编辑的文档并在生成 BOM 之前

重新编译项目。 

 

查看\ Altium Designer \ Templates 文件夹中的示例 Excel 模板。请注意，Fields 需要定义在

模板的 Column 区域之上或之下。 
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